SAFETY PRECAUTIONS AND ELECTRICAL REQUIREMENTS

WARNING: TO REDUCE THE RISK OF FIRE OR ELECTRICAL SHOCK, DO NOT EXPOSE THIS APPLIANCE TO RAIN OR OTHER MOISTURE.

CAUTION: TO REDUCE THE RISK OF ELECTRICAL SHOCK, DO NOT REMOVE COVER. NO USER-SERVICEABLE PARTS INSIDE. REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

WARNING: DO NOT PERMIT FINGERS TO TOUCH THE TERMINALS OF PLUGS WHEN INSTALLING OR REMOVING THE PLUG TO OR FROM THE OUTLET.

WARNING: IF NOT PROPERLY GROUNDED THE MOTU 896 COULD CAUSE AN ELECTRICAL SHOCK.

The MOTU 896 is equipped with a three-conductor cord and grounding type plug which has a grounding prong, approved by Underwriters' Laboratories and the Canadian Standards Association. This plug requires a matching three-conductor grounded type outlet as shown in Figure A below.

If the outlet you are planning to use for the MOTU 896 is of the two prong type, DO NOT REMOVE OR ALTER THE GROUNDING PRONG IN ANY MANNER. Use an adapter as shown below and always connect the grounding lug to a known ground. It is recommended that you have a qualified electrician replace the TWO prong outlet with a properly grounded THREE prong outlet. An adapter as illustrated below in Figure B is available for connecting plugs to two-prong receptacles.

Figure A

![Grounding plug](image)

Properly grounded 3-prong outlet

Figure B

![Adapter](image)

Grounding lug

Screw

Make sure this is connected to a known ground.

Two-prong receptacle

WARNING: THE GREEN GROUNDING LUG EXTENDING FROM THE ADAPTER MUST BE CONNECTED TO A PERMANENT GROUND SUCH AS TO A PROPERLY GROUNDED OUTLET BOX. NOT ALL OUTLET BOXES ARE PROPERLY GROUNDED.

If you are not sure that your outlet box is properly grounded, have it checked by a qualified electrician. NOTE: The adapter illustrated is for use only if you already have a properly grounded two-prong receptacle. Adapter is not allowed in Canada by the Canadian Electrical Code. Use only three wire extension cords which have three-prong grounding type plugs and three-prong receptacles which will accept the MOTU 896 plug.

IMPORTANT SAFEGUARDS

1. Read instructions - All the safety and operating instructions should be read before operating the MOTU 896.
2. Retain instructions - The safety instructions and owner's manual should be retained for future reference.
3. Heed Warnings - All warnings on the MOTU 896 and in the owner's manual should be adhered to.
4. Follow Instructions - All operating and use instructions should be followed.
5. Cleaning - Unplug the MOTU 896 from the computer before cleaning and use a damp cloth. Do not use liquid or aerosol cleaners.
6. Overloading - Do not overload wall outlets and extension cords as this can result in a risk of fire or electrical shock.
7. Power Sources - This MOTU 896 should be operated only from the type of power source indicated on the marking label. If you are not sure of the type of power supply to your location, consult your local power company.
8. Power-Cord Protection - Power-supply cords should be routed so that they are not likely to be walked on or pinched by items placed upon or against them. Pay particular attention to cords and plugs, convenience receptacles, and the point where they exit from the MOTU 896.
9. Lightning - For added protection for the MOTU 896 during a lightning storm, unplug it from the wall outlet. This will prevent damage to the MOTU 896 due to lightning and power line surges.
10. Servicing - Do not attempt to service the MOTU 896 yourself as opening or removing covers will expose you to dangerous voltage and other hazards. Refer all servicing to qualified service personnel.
11. Damage Requiring Service - Unplug the MOTU 896 from the computer and refer servicing to qualified service personnel under the following conditions.
   a. When the power supply cord or plug is damaged.
   b. If liquid has been spilled or objects have fallen into the MOTU 896.
   c. If the MOTU 896 has been exposed to rain or water.
   d. If the MOTU 896 does not operate normally by following the operating instructions in the owner's manual.
   e. If the MOTU 896 has been dropped or the cabinet has been damaged.
   f. When the MOTU 896 exhibits a distinct change in performance, this indicates a need for service.
12. Replacement Parts - When replacement parts are required, be sure the service technician has used replacement parts specified by the manufacturer or have the same characteristics as the original part. Unauthorized substitutions may result in fire, electric shock or other hazards.
13. Safety Check - Upon completion of any service or repairs to this MOTU 896, ask the service technician to perform safety checks to determine that the product is in safe operating conditions.

ENVIRONMENT

Operating Temperature: 10°C to 40°C (50°F to 104°F)

AVOID THE HAZARDS OF ELECTRICAL SHOCK AND FIRE

Do not handle the power cord with wet hands. Do not pull on the power cord when disconnecting it from an AC wall outlet. Grasp it by the plug.

INPUT

Line Voltage: 100 - 120 volts AC, RMS (US and Japan) or 220 - 250 volts AC, RMS (Europe). Frequency: 47 - 63 Hz single phase, Power: 7 watts maximum.

CAUTION: DANGER OF EXPLOSION IF BATTERY IS REPLACED. REPLACE ONLY WITH THE SAME OR EQUIVALENT TYPE RECOMMENDED BY MANUFACTURER. DISPOSE OF USED BATTERY ACCORDING TO MANUFACTURER'S INSTRUCTIONS.
Contents

5 Quick Reference: MOTU 896 Front Panel
6 Quick Reference: MOTU 896 Rear Panel
7 Quick Reference: MOTU FireWire Audio Control Panel
9 About the MOTU 896
13 Packing List and Macintosh System Requirements
15 Installing the MOTU 896 Hardware
33 Installing the MOTU 896 Macintosh Software
37 MOTU FireWire Audio Control Panel
45 The MOTU 896 and Digital Performer
51 The MOTU 896 and AudioDesk
57 The MOTU 896 and Other Audio Software
63 Sound Manager
67 Troubleshooting
About the Mark of the Unicorn License Agreement and Limited Warranty on Software

TO PERSONS WHO PURCHASE OR USE THIS PRODUCT: carefully read all the terms and conditions of the “click-wrap” license agreement presented to you when you install the software. Using the software or this documentation indicates your acceptance of the terms and conditions of that license agreement.

Mark of the Unicorn, Inc. (“MOTU”) owns both this program and its documentation. Both the program and the documentation are protected under applicable copyright, trademark, and trade-secret laws. Your right to use the program and the documentation are limited to the terms and conditions described in the license agreement.

Reminder of the terms of your license

This summary is not your license agreement, just a reminder of its terms. The actual license can be read and printed by running the installation program for the software. That license agreement is a contract, and clicking “Accept” binds you and MOTU to all its terms and conditions. In the event anything contained in this summary is incomplete or in conflict with the actual click-wrap license agreement, the terms of the click-wrap agreement prevail.

YOU MAY: (a) use the enclosed program on a single computer; (b) physically transfer the program from one computer to another provided that the program is used on only one computer at a time and that you remove any copies of the program from the computer from which the program is being transferred; (c) make copies of the program solely for backup purposes. You must reproduce and include the copyright notice on a label on any backup copy.

YOU MAY NOT: (a) distribute copies of the program or the documentation to others; (b) rent, lease or grant sublicenses or other rights to the program; (c) provide use of the program in a computer service business, network, time-sharing, multi-user system or other end-user arrangement without the prior written consent of MOTU; (d) translate, adapt, reverse engineer, decompile, disassemble, or otherwise alter the program or related documentation without the prior written consent of MOTU.

MOTU warrants to the original licensee that the disk(s) on which the program is recorded are free from defects in materials and workmanship under normal use for a period of ninety (90) days from the date of purchase as evidenced by a copy of your receipt. If failure of the disk has resulted from accident, abuse or misapplication of the product, then MOTU shall have no responsibility to replace the disk(s) under this Limited Warranty.

THIS LIMITED WARRANTY AND RIGHT OF REPLACEMENT IS IN LIEU OF, AND YOU HEREBY WAIVE, ANY AND ALL OTHER WARRANTIES, BOTH EXPRESS AND IMPLIED, INCLUDING BUT NOT LIMITED TO WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE LIABILITY OF MOTU PURSUANT TO THIS LIMITED WARRANTY SHALL BE LIMITED TO THE REPLACEMENT OF THE DEFECTIVE DISK(S), AND IN NO EVENT SHALL MOTU OR ITS SUPPLIERS, Licensors, OR AFFILIATES BE LIABLE FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES, INCLUDING BUT NOT LIMITED TO LOSS OF USE, LOSS OF PROFITS, LOSS OF DATA OR DATA BEING RENDERED INACCURATE, OR LOSSES SUSTAINED BY THIRD PARTIES EVEN IF MOTU HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, WHICH MAY VARY FROM STATE TO STATE. SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

Update Policy

In order to be eligible to obtain updates of the program, you must complete and return the attached Mark of the Unicorn Purchaser Registration Card to MOTU.

Copyright Notice

Copyright © 2001 by Mark of the Unicorn, Inc. All rights reserved. No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any human or computer language, in any form or by any means whatsoever, without express written permission of Mark of the Unicorn, Inc., 1280 Massachusetts Avenue, Cambridge, MA, 02138, U.S.A.

Limited Warranty on Hardware

Mark of the Unicorn, Inc. and S&S Research (“MOTU/S&S”) warrant this equipment against defects in materials and workmanship for a period of NINETY (90) DAYS from the date of original retail purchase. This warranty applies only to hardware products; MOTU software is licensed and warranted pursuant to separate written statements.

If you discover a defect, first write or call Mark of the Unicorn at (617) 576-2760 to obtain a Return Merchandise Authorization Number. No service will be performed on any product returned without prior authorization. MOTU will, at its option, repair or replace the product at no charge to you, provided you return it during the warranty period, with transportation charges prepaid, to Mark of the Unicorn, Inc., 1280 Massachusetts Avenue, MA 02138. You must use the product’s original packing material for in-shipment, and insure the shipment for the value of the product.

This warranty does not apply if the equipment has been damaged by accident, abuse, misuse, or misapplication; has been modified without the written permission of MOTU; or if the product serial number has been removed or defaced.

ALL IMPLIED WARRANTIES, INCLUDING IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE LIMITED IN DURATION TO NINETY (90) DAYS FROM THE DATE OF THE ORIGINAL RETAIL PURCHASE OF THIS PRODUCT.

THE WARRANTY AND REMEDIES SET FORTH ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHERS, ORAL OR WRITTEN, EXPRESS OR IMPLIED. No MOTU/S&S dealer, agent, or employee is authorized to make any modification, extension, or addition to this warranty.

MOTU/S&S ARE NOT RESPONSIBLE FOR SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES RESULTING FROM ANY BREACH OF WARRANTY, OR UNDER ANY LEGAL THEORY, INCLUDING LOST PROFITS, DOWNTIME, GOODWILL, DAMAGE OR REPLACEMENT OF EQUIPMENT AND PROPERTY AND COST OF RECOVERING REPROGRAMMING, OR REPRODUCING ANY PROGRAM OR DATA STORED IN OR USED WITH MOTU/S&S PRODUCTS.

Some states do not allow the exclusion or limitation of implied warranties or liability for incidental or consequential damages, so the above exclusion or limitation may not apply to you. This warranty gives you specific legal rights, and you may have other rights which vary from state to state.

MOTU, AudioDesk, MOTU, Mark of the Unicorn and the unicorn silhouette logo are trademarks of Mark of the Unicorn, Inc.

This equipment has been type tested and found to comply with the limits for a class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio or television equipment reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by any combination of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and the receiver.
- Plug the equipment into an outlet on a circuit different from that to which the receiver is connected.

If necessary, you can consult a dealer or experienced radio/television technician for additional assistance.

PLEASE NOTE: only equipment certified to comply with Class B FCC limits on RF emissions, pursuant to Part 15 of the FCC Rules. Those limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy, and if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television equipment reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by any combination of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and the receiver.
- Plug the equipment into an outlet on a circuit different from that to which the receiver is connected.

If necessary, you can consult a dealer or experienced radio/television technician for additional assistance.

WARNING: changes or modifications to this unit not expressly approved by the party responsible for compliance could void the user’s authority to operate the equipment.
Quick Reference: MOTU 896 Front Panel

This is a standard quarter-inch stereo headphone jack. Its output matches the main outs on the rear panel.

The MOTU 896 lets you monitor any analog or AES/EBU input (or input pair) via the main outs (and the headphone out). This knob controls the level of this monitored signal. This feature is called CueMix Plus™.

This toggle switch provides phantom power for a condenser mic plugged into this input. Up is on.

These 10-segment level meters are dedicated solely to the 896’s eight analog inputs. The top red ‘over’ LED lights up when the signal reaches full scale—for even just one sample—and remains illuminated until you shut it off. The second red LED below only lights up momentarily so that you can continue to adjust the level even after clipping has just occurred.

The MOTU 896 lets you monitor any analog or AES/EBU input (or input pair) via the main outs (and the headphone out). Use the MOTU FireWire Audio Control Panel to choose. The LEDs to the right indicate what you are currently monitoring.

The light that is illuminated here tells you which bank (analog in, ADAT in, or ADAT out) you are monitoring with the programmable meter bank to the right.

The lights indicate the global sample rate at which the MOTU 896 is operating. Use the MOTU FireWire Audio Control Panel to set the sample rate or to choose an external clock source, from which the sample rate will be derived. When no sample clock is currently present, these lights flash. For example, if you’ve set the MOTU 896 to slave to an external clock, such as ADAT, but there is no clock signal currently being detected, these lights will flash.

These eight trim knobs provide gain adjustment within a range of about 40dB for each analog input (when the 3-way switch on the rear panel is set to MIC or LINE). If the 3-way switch is set to +4/FIXED, the corresponding front-panel trim pots are bypassed. Because each input also has a microphone preamp, you can plug just about anything into them: a microphone, a guitar, a synth—whatever you name it.

For a microphone or unamplified instrument pickup, set the rear-panel 3-way switch to MIC, plug in your mic (XLR or quarter-inch plug) flip on 48V phantom power (if necessary) and use the trim knob as needed to adjust the level.

FireWire is a “plug-and-play” protocol. That means that you can turn off the MOTU 896 and turn it back on (or even unplug it) without restarting your computer. Keep in mind, however, that if you wish to change the MOTU 896’s settings in the MOTU FireWire Audio Control Panel, the MOTU 896 needs to be plugged in and switched on.

Connect a standard foot switch here for hands-free punch-in and punch-out during recording. For details about how to set this up, see “Enable Pedal” on page 40.
These AES/EBU connectors can handle any supported sample rate (44.1, 48, 88.2 or 96), and they are also equipped with a sample rate converter so you can input or output at a different rate than the 896. For details, see "Syncing AES/EBU devices" on page 26.

Quick Reference: MOTU 896 Rear Panel

These two XLR jacks serve as the MOTU 896's main analog outputs. You can connect them to a set of powered studio monitors and then control the volume from the front panel "Volume" knob.

The signal that comes out of these outputs is a mix of analog outputs 1 and 2 and any live CueMix™ Plus input that you have chosen to monitor from a MOTU 896 input (or input pair). To hear disk tracks on these main outs, assign the disk tracks (and master faders) to Analog Outs 1-2.

Analog outputs 1 and 2 are duplicated on the MOTU 896's main outputs (to the left), as well as the front panel stereo headphone jack. However, these outputs do not include any live CueMix™ Plus audio.

Analog outputs 1 and 2 are equipped with 24-bit, 128x oversampling enhanced multibit A/D converters capable of 44.1, 48, 88.2 and 96 kHz recording.

The MOTU 896's eight analog inputs are Neutrik™ combo connectors that accept either an XLR plug or a quarter-inch plug. They have 24-bit, 64x oversampling converters. Each input is equipped with a 3-way input level switch with three settings:

- **LINE**: Use this setting for +4dB or -10dB inputs, such as synthesizers or consumer audio equipment. Adjust the input level as needed with the corresponding front panel Trim control and level meter for this input. This setting offers a trim range of around 30dB (approximately -16dBu to +15dBu).

- **+4 / FIXED**: Use this setting for +4 balanced inputs for which you do not wish to modify the gain. This position disengages the front panel trim knob. This setting also provides slightly more attenuation than the LINE setting, allowing levels up to +18dBu.

- **MIC**: This setting feeds the input signal (XLR or quarter-inch) to the built-in preamp for additional gain. Use it for any microphone or unamplified instrument pickup. Engage phantom power for condenser mics with the front-panel 48V switch (up is on). Use the corresponding front-panel trim knob and level meter to adjust the input level as needed. This setting offers a trim range of around 40dB (approximately -37dBu to +5dBu).

Daisy-chain up to four 896's to a single FireWire bus. You can also connect a MOTU 828, Glyph M Project FireWire hard drive or other FireWire device. For details, see "Connecting multiple MOTU 896 interfaces" on page 31.

Use the word clock input and output for digital transfers with devices that cannot slave to the clock supplied by the digital I/O connection with the 896.
Quick Reference: MOTU FireWire Audio Control Panel

Determines the master clock source for your entire MOTU 896 system. If you're just using the analog ins and outs, set this to "Internal". Other settings are for digital transfers via AES/EBU or external synchronization via the ADAT SYNC in or Word Clock port. If you have multiple MOTU FireWire interfaces, you'll see all eligible clock sources from all available interfaces.

Choosing a smaller setting here reduces the delay you may hear when listening to live input that you are running through effects plug-ins in your software. But lower settings also increase the strain on your computer. Details about Samples Per Buffer are on page 39.

If you have multiple MOTU FireWire audio interfaces connected to your computer, each interface appears in this menu, which displays the settings for the chosen interface below. Use the "Disable" check box to take the interface off-line without shutting off its power. Doing so frees up FireWire bandwidth.

This menu provides several options for the MOTU 896's AES/EBU sample rate conversion. Further details are in "Syncing AES/EBU devices" on page 26.

How to access these settings

The MOTU FireWire Audio Control Panel gives you complete control over the settings in your MOTU 896 hard disk recording system. There are several ways to access these settings. But the settings are the same, regardless of how you access them.

- From the Mac OS Apple menu, choose Control Panels>MOTU FireWire Audio.
- From within AudioDesk or Digital Performer, go to the Basics menu and choose MOTU Audio System options>Configure Hardware Driver.
- Click on the MOTU FireWire Audio icon in the Macintosh Control Strip.
CHAPTER 1  About the MOTU 896

OVERVIEW
The MOTU 896 is a computer-based hard disk recording system for Mac OS and Windows that offers 18 simultaneous inputs and outputs. The MOTU 896 consists of a standard 19-inch, double-space, rack-mountable I/O unit that connects directly to a computer via a standard IEEE 1394 FireWire™ cable. The MOTU 896 offers the following:

- Operation at 44.1, 48, 88.2 or 96 kHz
- Eight 24-bit analog outputs individually switchable between +4 and -10dB operation
- Eight 24-bit analog inputs equipped with Neutrik "combo" jacks and independent 3-way level switch for MIC, LINE or +4/FIXED inputs
- Eight-channel ADAT optical digital I/O
- AES/EBU with sample rate conversion
- Two extra analog main outs
- Eight mic preamps (one on each input)
- Independent 48V phantom power for each input
- Independent front-panel trim for each input
- Sample-accurate ADAT sync input
- Word clock input and output
- Two FireWire jacks for chaining multiple units
- Foot switch input for hands-free punch-in/out
- Front-panel Headphone jack
- Main volume knob (for headphone + main outs)
- CueMix™ Plus no-latency monitoring
- 10-segment LED level meters for each input
- 10-segment programmable LEDs for analog output, ADAT input or ADAT output
- 10-segment programmable LEDs for AES/EBU input or output
- Switchable power supply (110V or 220V)

With a variety of I/O formats, mic preamps, no-latency monitoring of live input and synchronization capabilities, the MOTU 896 is a complete, portable “studio in a box” when used with a Macintosh or Windows computer. The MOTU 896 system includes AudioDesk™, full-featured audio workstation software for Mac OS that supports both 16-bit and 24-bit recording. Also included is an ASIO driver for multi-channel operation with any Macintosh audio software that supports ASIO drivers.

THE MOTU 896 I/O REAR PANEL
The MOTU 896 rear panel has the following connectors:

- Eight 24-bit XLR analog outputs, each equipped with an independent 2-way output level switch (+4 or -10dB)
- Eight 24-bit Neutrik “combo” (XLR + balanced quarter-inch) analog inputs, each equipped with an independent 3-way level switch (MIC, LINE, +4/FIXED), mic preamp, front-panel 48V phantom power switch, and front-panel trim knob
- One set of ADAT optical ‘light pipe’ connectors (8 channels of ADAT optical input and output)
- AES/EBU input and output
- Two XLR main analog outputs with volume knob (on the front panel)
- One 9-pin ADAT SYNC IN connector
BNC word clock input and output
Two 1394 FireWire jacks

18 simultaneous inputs and outputs
All MOTU 896 inputs and outputs can be used simultaneously, for a total of 18 inputs and outputs (8 analog + 8 ADAT optical + 2 AES/EBU).

Analog
The analog inputs are equipped with 24-bit, 64x oversampling A/D converters. The analog outputs have 24-bit 128x oversampling D/A converters. All audio is carried to the computer in a 24-bit data stream. Each output can be individually switched between either +4 or -10dB operation. Each input can be individually set to one of three input levels: MIC (feeds the mic preamp and includes front-panel trim and switchable 48V phantom power), LINE (for -10dB inputs with front-panel trim) and +4/FIXED (for +4 “hot” inputs for which no gain adjustment in the 896 is desired).

Mic preamps
All eight analog inputs are equipped with a mic preamp on a Neutrik™ combo-style connector that accepts either an XLR or quarter-inch plug. Defeatable 48V phantom power is supplied by a front panel switch. In addition, each input has its own trim knob, which provides a trim range of approximately 40dB.

Main Outs
For main stereo output, analog outputs 1 and 2 are duplicated as a stereo pair of XLR jacks. If an input (or input pair) is being monitored via the MOTU 896’s CueMix™ Plus monitoring feature, the monitored signal is summed with the main outs. You can control the volume of the main outs with the front panel volume knob. You can independently control the CueMix Plus monitored signal with the Monitor level knob on the front panel.

ADAT optical
The MOTU 896 optical jacks support eight channels of 24-bit ADAT optical digital audio input and output at either 44.1 or 48 kHz.

AES/EBU with sample rate conversion
The MOTU 896 rear panel provides standard AES/EBU digital inputs and outputs that support digital I/O at 44.1, 48, 88.2 and 96 kHz. In addition, input or output can be sample-rate converted to any of these sample rates in situations that call for a different rate than the 896’s global sample rate.

ADAT sync: sample-accurate synchronization
The MOTU 896’s standard 9-pin ADAT SYNC IN connector provides sample-accurate synchronization with all Alesis ADAT tape decks connected to the system—or any device that supports the ADAT sync format. For example, if you digitally transfer a single track of material from an ADAT via light pipe into audio workstation software on the computer, and then transfer the track back to the ADAT, it will be recorded exactly at its original location, down to the sample.

Word clock
The MOTU 896 provides standard word clock that can slave to any supported sample rate. In addition, word clock can resolve to and generate “high” and “low” sample rates. For example, if the MOTU 896 global sample rate is set to 96 kHz, the word clock input can resolve to a “low” rate of 48 kHz. Similarly, when the MOTU 896 is operating at 96 kHz, the MOTU 896 FireWire Audio Control Panel lets you choose a word clock output rate of 48 kHz (“System clock ÷ 2”).

Punch in/out
The quarter-inch Punch in/out jack accepts a standard foot switch. When you push the foot switch, the MOTU 896 triggers a programmable keystroke on the computer keyboard. For example, with MOTU’s Digital Performer audio sequencer software, the foot switch triggers the 3 key on the...
numeric keypad, which toggles recording in Digital Performer. Therefore, pressing the foot switch is the same as pressing the 3 key. The MOTU FireWire Audio Control Panel software lets you program any keystroke you wish.

**1394 FireWire**

The two 1394 FireWire jacks accept a standard IEEE 1394 FireWire cable to connect the MOTU 896 to a FireWire-equipped Macintosh or Windows computer. Both jacks can be used together to connect up to four 896’s (or other MOTU FireWire audio interfaces) to a single FireWire chain.

**THE MOTU 896 FRONT PANEL**

**Headphone output and main volume control**

The MOTU 896 front panel includes a quarter-inch stereo headphone output jack and volume knob. The headphone output matches the main stereo outs. An accompanying switch allows you to control the volume of the phones only (down) or both the phones and the main outs (up).

**CueMix™ Plus no-latency monitoring**

The MOTU 896 provides CueMix™ Plus no-latency monitoring from any input (or input pair). The CueMix monitored signal, mixed with outputs 1-2, appears on the main outs and headphone jack. An independent volume knob is provided for the monitored signal.

**Input trim knobs and phantom power switch**

The front-panel input trim knobs provide independent trim for the eight analog inputs. The phantom power switch for each input provides 48V phantom power. Up is on; down is off.

**Metering**

The front panel of the MOTU 896 displays two eight-channel banks of 10-segment ladder LEDs. The left-hand bank always shows the eight analog inputs. The right-hand bank shows one of three different banks, which you can specify in the MOTU FireWire Audio Control Panel software: Analog out, ADAT input, or ADAT output. A status LED to the left shows which bank you are currently viewing.

The 896 front panel also displays stereo meters for the main analog outs and AES/EBU. The AES/EBU meters can display either input or output as specified in the MOTU FireWire Audio Control Panel software. A status LED to the right shows whether you are viewing input or output.

**16-BIT AND 24-BIT RECORDING**

The MOTU 896 system handles all data with a 24-bit signal path, regardless of the I/O format. You can record and play back 16-bit or 24-bit audio files at 44.1, 48, 88.2 or 96 KHz via any of the MOTU 896’s analog or digital inputs and outputs (except optical, which only supports 44.1 or 48). 24-bit audio files can be recorded with any compatible host application that supports 24-bit recording.

**AUDIODESK**

AudioDesk is a full-featured, 24-bit audio workstation software package included with the MOTU 896 system (for Macintosh only). AudioDesk provides multi-channel waveform editing, automated virtual mixing, graphic editing of ramp automation, real-time effects plug-ins with 32-bit floating point processing, crossfades, support for many third-party audio plug-ins (in the MOTU Audio System and Adobe Premiere formats), background processing of file-based operations, sample-accurate editing and placement of audio, and more.

**DIGITAL PERFORMER**

The MOTU 896 system is fully integrated with MOTU’s award-winning Digital Performer audio sequencer software package.
OTHER HOST AUDIO SOFTWARE
The MOTU 896 system includes a standard Mac OS Sound Manager driver for stereo I/O with any audio application that supports Sound Manager.

The MOTU 896 also includes a Macintosh ASIO driver for multi-channel compatibility with any audio application that supports ASIO drivers.

A COMPUTER-BASED SYSTEM
Regardless of what software you use with the MOTU 896, the host computer determines the number of tracks the software can record and play simultaneously, as well as the amount of real-time effects processing you can apply to your mix. A faster computer with more RAM and faster hard drives will allow more simultaneous tracks and real-time effects than a slower computer with less RAM and slower hard drives. Today’s fastest computers can typically play as many as 32 tracks or more. Standard third-party SCSI acceleration products can also help you achieve higher track counts.
PACKING LIST
The MOTU 896 ships with the items listed below. If any of these items are not present in your MOTU 896 box when you first open it, please immediately contact your dealer or MOTU.

- One MOTU 896 I/O rack unit
- One 1394 “FireWire” cable
- Power cord
- One MOTU 896 Mac/Windows manual
- One AudioDesk Manual
- One cross-platform CD-ROM
- Product registration card

MACINTOSH SYSTEM REQUIREMENTS
The MOTU 896 system requires the following Macintosh system:

- A G3/300Mhz Power Macintosh or faster equipped with at least one FireWire port
- At least 64 Mb (megabytes) of RAM (128 Mb or more is recommended)
- Mac OS version 8.6 or later (MacOS 9 or later is recommended)
- FireWire Enabler and FireWire Support system extensions 2.4 or later
- A large hard drive (preferably at least 8 Gb)

PLEASE REGISTER TODAY!
Please send in the registration card included with your MOTU 896 system. As a registered user, you will be eligible to receive on-line technical support email and announcements about product enhancements as soon as they become available. Only registered users receive these special update notices, so please, complete and mail this registration card!

There is also an AudioDesk software registration card found at the beginning of your AudioDesk manual. Please be sure to fill out and return this card as well, so that you will be eligible to receive on-line technical support email and announcements about AudioDesk software enhancements as soon as they become available.

Thank you for taking the time to register your new MOTU products!
CHAPTER 3 Installing the MOTU 896 Hardware

OVERVIEW
Here's an overview for installing the MOTU 896:

Connect the MOTU 896 .............................. 15
Connect the MOTU 896 audio interface to the computer with the supplied FireWire cable.

Connect inputs and outputs ...................... 16
Make optical and analog connections as desired.

A typical studio setup (no mixer) ............. 17
An example setup for computer-based mixing/FX.

Using the MOTU 896 with a mixer .......... 18
An example setup for a mixer-based studio.

Making sync connections ....................... 19
If you need to resolve the MOTU 896 with other devices in your studio, make the necessary synchronization connections.

Do you need a synchronizer? ................. 20
Sample-accurate sync ............................ 21
Sample-accurate sync with ADATs ........... 22
ADAT sync with no synchronizer ............ 23
Sync to SMPTE, word clock, video .......... 24
Syncing optical devices ....................... 25
Syncing AES/EBU devices .................... 26
Syncing to word clock ....................... 29
Syncing large systems ....................... 30
Connecting multiple MOTU 896 interfaces ... 31

CONNECT THE MOTU 896 INTERFACE
1 Plug one end of the MOTU 896 FireWire cable (included) into the FireWire socket on the computer as shown below in Figure 3-1.

2 Plug the other end of the FireWire cable into the MOTU 896 I/O as shown below in Figure 3-1.
CONNECT INPUTS AND OUTPUTS
The MOTU 896 audio interface has the following input and output connectors:

- 8 XLR analog outputs
- 8 Neutrik™ XLR/quarter-inch analog inputs
- 2 XLR main outs
- AES/EBU input/output
- ADAT optical input/output

Analog inputs
The MOTU 896 analog inputs are Neutrik combo connectors that accept either a male XLR plug or a quarter-inch plug. You can use either type of plug, regardless of whether it’s a mic, synth, or whatever. Set the 3-way input level switch as follows:

For a microphone or unamplified instrument pickup, set the rear-panel 3-way switch to MIC, plug in your mic (XLR or quarter-inch plug) flip on 48V phantom power (if necessary) and use the trim knob as needed to adjust the level.

For -10dB (unbalanced) inputs (like synths) or +4 (balanced) signals that may need to be boosted, set the rear panel 3-way switch to LINE and use the trim knob to adjust the level. You can use either an XLR or quarter-inch plug. (Note: the complete trim range, from all the way down with the MIC setting to all the way up with the LINE setting is around 55dB total. The MIC setting provides a 40dB range and the LINE setting offers a 30dB range with some overlap between them.)

If you have +4 inputs for which you’d like to maintain unity gain, set the 3-way switch to +4/FIXED. Use either an XLR or quarter-inch plug.

Analog outputs
Connect an XLR cable and set the desired output level with the 2-way level switch (+4 or -10dB).

ADAT optical
Use standard ADAT optical cables. Reminder: optical goes OUT to IN and IN to OUT, like MIDI.

AES/EBU
Connect standard AES/EBU input and output. High sample rates (88.2 & 96 kHz) are supported.

Main outs
The main outputs, as well as the headphone output on the front panel, match the output from Analog outputs 1-2. In addition, any live inputs that are being monitored via CueMix™ Plus are summed to the signal on the main outs. The main out volume can be controlled by the main volume knob on the front panel (when the switch is up). In a typical studio, the main outs are intended for a pair of monitors. However, if you are using the MOTU 896 in other ways, such as in a live performance situation, you could use the main outs for stage monitors while outputs 1 and 2 are used for the PA.

Using an external mixer
The MOTU 896 can be used without a mixer, as shown on the opposite page in Figure 3-3. In this setup, all mixing and effects processing occurs in the audio software running on the computer. If you’d like to use external mixing, see “Using the MOTU 896 with a mixer” on page 18.
A TYPICAL STUDIO SETUP (NO MIXER)
Here is a typical MOTU 896 studio setup. This rig can be operated without an external mixer. All mixing and processing can be done in the computer with audio software. During recording, you can use the MOTU 896’s CueMix™ Plus no-latency monitoring to listen to what you are recording via the main outs. The MOTU FireWire Audio Control Panel software lets you choose the input (or input pair) that you wish to monitor. Guitar can be processed with plug-ins on the computer, or with an amp.

Figure 3-3: A typical MOTU 896 studio setup.
USING THE MOTU 896 WITH A MIXER
While there are many ways to use the MOTU 896 with an external mixer, typically the MOTU 896 serves as a multi-channel “pipeline” between the mixer and the computer. If your mixer is analog, connect the analog section of the MOTU 896 to your mixer. If your mixer is digital, and it has ADAT optical I/O, you can connect them optically as shown below in Figure 3-4. Add more 896’s for additional banks of eight-channel I/O. The MOTU 896’s available analog and AES/EBU inputs and outputs can serve as an extension to the mixer I/O, but then you will probably find yourself mixing in two places: the mixer and the computer. A word of advice: if you would like to use the MOTU 896 with an external mixer, use the MOTU 896 with the mixer for mixing. Trying to mix large multitrack projects in two places can become very cumbersome very quickly.

Figure 3-4: Using the MOTU 896 with a digital mixer.
MAKING SYNC CONNECTIONS

If you connect devices digitally to the MOTU 896, or if you need to synchronize the MOTU 896 with an outside time reference such as SMPTE time code, you must pay careful attention to the synchronization connections and clock source issues discussed in the next few sections.

Do you need to synchronize the MOTU 896?

If you will be using only the MOTU 896’s analog inputs and outputs (and none of its digital I/O), and you have no plans to synchronize your MOTU 896 system to SMPTE time code, you don’t need to make any sync connections. You can skip this section and proceed to chapter 4, “Installing the MOTU 896 Macintosh Software” (page 33). After you install the MOTU 896 software, you’ll open the MOTU FireWire Audio Control Panel and set the Clock Source setting to Internal as shown below in Figure 3-5. For details, see chapter 5, “MOTU FireWire Audio Control Panel” (page 37).

Situations that require synchronization

There are three general cases in which you will need to synchronize the MOTU 896 with other devices:

- Synchronizing the MOTU 896 with other digital audio devices so that their digital audio clocks are phase-locked (as shown in Figure 3-6)
- Slaving the MOTU 896 system to SMPTE time code, such as from a video deck or an analog multitrack tape recorder
- Both of the above

Synchronization is critical for clean digital I/O

Synchronization is critical in any audio system, but it is especially important when you are transferring audio between digital audio devices. Your success in using the MOTU 896’s digital I/O features depends almost entirely on proper synchronization. The following sections guide you through several recommended scenarios.

Be sure to choose a digital audio clock master

When you transfer digital audio between two devices, their audio clocks must be in phase with one another — or phase-locked. Otherwise, you’ll hear clicks, pops, and distortion in the audio — or perhaps no audio at all.

There are two ways to achieve phase lock: slave one device to the other, or slave both devices to a third master clock. If you have three or more digital audio devices, you need to slave them all to a single master audio clock.

Also remember that audio phase lock can be achieved independently of time code (location). For example, one device can be the time code master while another is the audio clock master. But only one device can be the audio clock master. If you set things up with this rule in mind, you’ll have trouble-free audio transfers with the MOTU 896.
DO YOU NEED A SYNCHRONIZER?
Whether or not you'll need a synchronizer depends on your gear and what you will be doing with your MOTU 896 system. The following pages give you specific information about common sync scenarios. At least one of them will likely apply to you. Here are some general considerations to help you figure out if you need (or want) a synchronizer for you MOTU 896 system.

You don't need a synchronizer if...
As explained earlier, the MOTU 896’s digital audio clock must be phase-locked (synchronized) with other connected digital audio devices to achieve clean digital transfers between them. Can this be accomplished without an additional digital audio synchronizer? It depends on the nature of the other devices, and what you want to do with them. You don't need a synchronizer if the device has a way of locking itself directly to the MOTU 896’s clock (via ADAT lightpipe or AES/EBU), AND if the device carries no sense of location in time. A digital mixer is a good example: it can slave to its ADAT lightpipe connection from the MOTU 896, and it has no sense of time; it just passes audio through for mixing.

An ADAT, on the other hand, does have a sense of location in time, either via SMPTE time code or via its own sample address time format (ABS). If you want to fly tracks back and forth between your computer and ADAT tapes while maintaining the audio's position in time, the ADAT SYNC port on the MOTU 896 lets you do so without a separate synchronizer — and with sample-accurate precision (if you're using AudioDesk, Digital Performer, or an ASIO 2.0-compatible program that supports sample-accurate sync). Just connect the MOTU 896 directly to the ADAT as discussed in “ADAT sync with no synchronizer” on page 23. But if you also want transport control over the entire rig (including the ADAT) from your audio software, you'll need a MIDI Machine Control-compatible synchronizer such as MOTU’s MIDI Timepiece AV, as discussed in “Sample-accurate sync” on page 21. If you are simply using the ADAT as a backup medium where you transfer eight tracks at a time and don't care about their exact location, no synchronizer is required. You can simply slave the ADAT to the optical output from the MOTU 896 as explained in “Syncing optical devices” on page 25.

Transport control from your computer
If you have ADATs or other digital recording devices connected to the MOTU 896, your audio software — if it supports MIDI Machine Control (MMC) — allows you to control the transports of everything from your computer. Most advanced audio programs support MMC. To do this, you'll also need an MMC-compatible ADAT synchronizer such as a MOTU MIDI Timepiece AV or Digital Timepiece. Synchronizers like these allow you to play, stop, rewind and locate all of your tape decks using the transport controls in the audio software. If your audio software supports ASIO 2, you can do so with sample-accurate precision. The following pages show you how to achieve MMC control, where possible.

Continuous sync to SMPTE / MTC
If you need to synchronize the MOTU 896 (and your audio software) to SMPTE time code, this requires a dedicated synchronizer, which continuously resolves the MOTU 896 to SMPTE time code, while simultaneously resolving your audio software to MIDI Time Code. When the MOTU 896 is continuously resolved, audio playback will never drift with respect to the time code. Again, the MOTU MIDI Timepiece AV and Digital Timepiece are affordable examples of this type of synchronizer. The following pages illustrate how to set up this type of synchronization with various kinds of gear. Regardless of the specific equipment you have, you can follow the basic connections shown.
SAMPLE-ACCURATE SYNC

Your MOTU 896 system provides you with the most advanced, accurate synchronization possible with Alesis ADATs (Type I and II) or any device that supports ADAT sync. Figure 3-8 below shows a few best-case scenarios for syncing the MOTU 896 with ADATs (in ABS time). Below is a brief explanation of the benefits you achieve with these setups.

Sample accurate locating

With sample accurate locating, when you transfer audio between AudioDesk (or any other sample-accurate host software such as Digital Performer) and ADATs, the audio will not drift in time — even by as little as one sample. This is the tightest possible synchronization between digital audio devices. The timing in your audio will not be affected in any way by the process of transferring it between the MOTU 896 and your ADATs. Sample-accurate locating is only possible with software that supports this feature, such as AudioDesk, Digital Performer, Cubase VST or other ASIO 2 compatible audio software.

Transport control from your computer

If you have a MIDI Timepiece AV, Digital Timepiece or any ADAT synchronizer that also supports MIDI Machine Control (MMC), you can play, stop, rewind and locate all of your ADATs using the transport controls in the audio software running on your computer. This includes cueing features like markers, position bars, playback wipers, time rulers, etc.

Continuous sync to SMPTE / MTC

This means that the MOTU 896 can be continuously resolved to SMPTE time code (or MIDI Time Code) via a dedicated synchronizer, such as the MIDI Timepiece AV. When the MOTU 896 is continuously resolved, audio playback will never drift with respect to time code.

---

**Figure 3-8:** AudioDesk and Digital Performer support sample-accurate transfers with ADATs.

<table>
<thead>
<tr>
<th>Tape recorder/ Sync format</th>
<th>Software</th>
<th>Synchronizer</th>
<th>Sample accurate locating</th>
<th>Transport control from computer</th>
<th>Continuous sync to SMPTE / MTC</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADAT</td>
<td>AudioDesk, Cubase VST or Digital Performer</td>
<td>MIDI Timepiece AV or Digital Timepiece</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>ADAT</td>
<td>AudioDesk, Cubase VST or Digital Performer</td>
<td>BRC (or any MMC capable ADAT synchronizer)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>ADAT</td>
<td>AudioDesk, Cubase VST or Digital Performer</td>
<td>None</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

---

**Figure 3-8:** These recommended combinations of hardware and software offer the tightest sync possible between the MOTU 896 and digital audio tape decks in the form of sample-accurate locating between the software and the tape decks. Sample accurate locating is possible with ADATs even without a MIDI Timepiece AV or Digital Timepiece, although you give up transport control from the computer without them.
SAMPLE-ACCURATE SYNC WITH ADATs

The MOTU 896 can achieve sample-accurate sync with AudioDesk, Digital Performer, or any ASIO 2.0-compatible audio software that also supports sample-accurate sync. Connect the MOTU 896 to the end of the ADAT chain and make the software settings shown below in Figure 3-10. If you will be using the ADAT for its analog inputs and outputs only (you won’t be using any tapes in the ADAT), treat it as an ‘optical’ device. See “Syncing optical devices” on page 25.

In AudioDesk or Digital Performer:
1. Choose Receive Sync the Basics menu.
2. Choose the Sample-accurate option shown to the left.

To set the MOTU 896 hardware clock source for sample-accurate sync:
1. Choose MOTU Audio System>Configure Hardware Driver from the Basics menu in AudioDesk or Digital Performer, or run the MOTU FireWire Audio Control Panel.
2. Choose ADAT 9-pin from the Clock Source menu as shown above.
3. Make sure the Sample Rate setting matches the tape decks and synchronizer.

In AudioDesk or Digital Performer, turn on MIDI Machine Control by pressing this button (to make the arrow black). This brings on line all the tape decks connected to the DTP or MTP AV.

AudioDesk automatically scans the DTP or MTP AV for ADATs, and they appear here. Just make sure you have the DTP or MTP AV in your FreeMIDI setup.

The above is also true for any version of Digital Performer later than 2.42. (The MOTU 896 requires Version 2.42 or higher.)

For sample-accurate sync settings in Cubase VST, see “Sample-accurate sync to ADAT” on page 61.

What this setup provides
✓ Sample-accurate locating between all ADATs, the MOTU 896, and AudioDesk or Digital Performer.
✓ Transport control of everything from the computer.
✓ Continuous sync to SMPTE time code and other sync sources (the other source is the transport master in this case).

Figure 3-10: Connections for sample-accurate sync between one or more ADATs and the MOTU 896.
ADAT SYNC WITH NO SYNCHRONIZER

Even if you don't have an ADAT synchronizer, you can achieve sample-accurate sync between ADATs, the MOTU 896, and any sample-accurate software (such as AudioDesk or Digital Performer). Just connect the MOTU 896 to the end of the ADAT sync chain as shown below. But without the synchronizer, you don't get transport control from your computer, nor can you slave the system to external SMPTE time code. Instead, you have to play, stop, rewind and cue the system from the transports on your ADAT (or via an Alesis LRC). If you will be using the ADAT for its analog inputs and outputs only (you won't be using any tapes in the ADAT), treat it as an 'optical' device. See "Syncing optical devices" on page 25.

What this setup provides

- ✔ Sample-accurate locating between all ADATs, the MOTU 896, and AudioDesk or Digital Performer.
- ✗ No transport control of everything from the computer
- ✗ No continuous sync to SMPTE time code and other sources

In AudioDesk or Digital Performer:

1. Choose Receive Sync from the Basics menu.
2. Choose the Sample-accurate option shown to the left.

To set the MOTU 896 hardware clock source for sample-accurate sync:

1. Choose MOTU Audio System>Configure Hardware Driver from the Basics menu in AudioDesk or Digital Performer, or run the MOTU FireWire Audio Control Panel.
2. Choose ADAT 9-pin from the Clock Source menu as shown to above.
3. Make sure the Sample Rate setting matches the tape decks and synchronizer.

In AudioDesk or Digital Performer:

1. Make sure that Slave to External Sync is checked in the Basics menu.
2. Click the play or record button. The software will then wait for you to start your ADAT.
3. Press the Play button on the front panel of your ADAT to initiate playback or recording.

For sample-accurate sync settings in Cubase VST, see "Sample-accurate sync to ADAT" on page 61.

INSTALLING THE MOTU 896 HARDWARE
SYNC TO SMPTE, WORD CLOCK, VIDEO

To synchronize (continuously resolve) the MOTU 896 with SMPTE time code, word clock, video or blackburst, you will need a MOTU Digital Timepiece, MIDI Timepiece AV or any other universal synchronizer equipped with word clock. The synchronizer resolves continuously to the chosen time base, and the MOTU 896 slaves to the synchronizer via word clock. In addition, the audio software running on the computer slaves to MIDI Time Code generated by the synchronizer. How accurate will transfers be between your audio software and other audio devices? As good as the resolution of MIDI time code, which — at 30 fps — provides quarter frame resolution of 120th of a second (367 samples at 44.1 KHz). But if you are running your synchronizer under its own internal clock (triggering it via MMC from your software), you will probably get even tighter timing than that — perhaps as good as ±50 samples.

What this setup provides

✗ No sample-accurate locating

✓ Timing accuracy that is at least as good as MIDI time code (quarter-frame) — and maybe even tighter

✗ No transport control of from the computer

✓ Continuous sync to SMPTE time code and other sync sources (the other source is the transport master in this case)

Figure 3-12: Resolving the MOTU 896 to an external time base, such as SMPTE time code, word clock, or video. In this example, an S-VHS video deck is supplying SMPTE time code (address) and video (as the time base). For examples of other sources, consult the MIDI Timepiece AV manual (or other synchronizer).
SYNCING OPTICAL DEVICES

The word optical is our short-hand way of referring to any device that connects to the MOTU 896 via an optical cable. But we make a further distinction: an optical device is also one that doesn't care about sample location. An example is a digital mixer. Since a digital mixer is not a recording device, it has no sense of sample location like an ADA T does. An ADA T can cue to a specific sample number (e.g. sample number 43,478, 103) — as can any device that supports ADAT sync, but most digital mixers simply mix and process audio digitally, with no sense of a specific sample location. There are many other devices that fall into this category, including digital effects processors, synthesizers, A/D converters, and many more.

For ADATs or other devices that support ADAT sync, synchronize them with the MOTU 896 as described in the previous sections of this chapter.

For optical devices, such as digital mixers, all you have to do is make sure that their digital audio clock is phase-locked (in sync with) the MOTU 896. There are three ways to do this:

- Slave the optical device to the MOTU 896
- Slave the MOTU 896 to the optical device
- Slave both the optical device and the MOTU 896 to a third master clock (such as a Digital Timepiece or MIDI Timepiece AV synchronizer)

Figure 3-13: Three setups for synchronizing an optical device with the MOTU 896. You can slave the optical device to the MOTU 896 or vice versa with their optical connections. For more elaborate setups, you can slave both to a digital audio synchronizer like the Digital Timepiece. Don't use any of these setups for an ADAT or other optical device that records. Instead, see “Sample-accurate sync with ADATs” on page 22.
SYNCING AES/EBU DEVICES
If you would like to transfer stereo audio digitally between the 896 and another device that has AES/EBU I/O, connect it to the 896’s AES/EBU jacks with balanced, AES/EBU grade audio cables.

AES/EBU clock and sample rate conversion
The 896 AES/EBU section is equipped with a real-time sample rate converter that can be used for either input or output. This feature provide a great deal of flexibility in making digital transfers. For example, you can:

- Transfer digital audio into the 896 at a sample rate that is completely different than the 896 system clock rate.
- Transfer digital audio into the 896 without the need for any external synchronization arrangements.
- Transfer digital audio out of the 896 at double or half the 896 system clock rate.

Rate conversion does not add any appreciable noise to the audio signal (under -120 dB).

Digital audio phase lock
Without sample rate conversion, when you transfer digital audio between two devices, their audio clocks must be in phase with one another — or phase-locked — as demonstrated below in Figure 3-15. Otherwise, you’ll hear clicks, pops, and distortion in the audio, or perhaps no audio at all.

![Diagram showing two setups for synchronizing an AES/EBU device with the MOTU 896. In the top diagram, sync is achieved via the AES/EBU connection itself. In this case, you have to choose AES/EBU as the MOTU 896’s clock source when recording from the AES/EBU device. If you don’t want to have to worry about switching the Clock Source setting depending on the direction of the AES/EBU transfer, you can slave the AES/EBU device to word clock from the MOTU 896 or vice versa (not shown). The Word Clock connection maintains sync, regardless of the direction of the transfer.](image-url)
When transferring audio without sample rate conversion, two devices must have phased-locked audio clocks to prevent clicks, pops or other artifacts.

Without sample rate conversion, there are two ways to achieve phase lock: slave one device to the other, or slave both devices to a third master clock. If you have three or more digital audio devices, you need to slave them all to a single master audio clock.

Audio phase lock as shown above in Figure 3-16 can be achieved independently of time code (location). For example, one device can be the time code master while another is the audio clock master. But only one device can be the audio clock master.

Another benefit of direct master/slave clocking (without sample rate conversion) is that each slaved device remains continuously resolved to the master, meaning that there will be no drift over time. This form of synchronization is best for audio that needs to remain resolved to film, video, etc.

**Sample rate conversion**

With sample rate conversion (SRC), an extra level of master/slave clocking is added to the equation, as demonstrated below in Figure 3-17, which shows the clocking going on when you transfer digital audio from the 896 (AES/EBU OUT) to a DAT deck (AES/EBU IN) using SRC. Notice that with SRC, the DAT deck is not slaved to the 896’s system clock. Instead, their clocks are running completely independently of one another. But also notice that the DAT deck must still slave to the sample-rate-converted output from the 896 for a clean digital audio transfer (unless it has its own rate converter on its AES/EBU input).

**System clock, AES clock & rate convert settings**

When you are setting up AES/EBU input and output with the 896, pay careful attention to the following settings in the MOTU FireWire Audio Control Panel (see the quick reference overview on page 7):

- Clock source
- Sample rate conversion

These options are mentioned briefly in the following sections. For further details, see “Clock Source” on page 38 and “Sample Rate Conversion” on page 41.
Clocking scenarios for AES/EBU input

There are three possible clocking scenarios for the 896 AES/EBU input:

1. Simple transfer (slave the 896 system clock to the AES/EBU input signal — no sample rate conversion).

2. Sample rate convert the AES/EBU input.

3. Use word clock to resolve the 896 system clock and the other AES/EBU device with each other.

These three AES/EBU input scenarios are summarized below.

<table>
<thead>
<tr>
<th>Scenario 1</th>
<th>Scenario 2</th>
<th>Scenario 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Simple transfer</td>
<td>Rate convert</td>
</tr>
<tr>
<td>896 clock source setting</td>
<td>AES/EBU</td>
<td>Any setting except AES/EBU</td>
</tr>
<tr>
<td>Sample rate conversion setting</td>
<td>None</td>
<td>AES In</td>
</tr>
<tr>
<td>Required 896 connections</td>
<td>AES/EBU In</td>
<td>AES In</td>
</tr>
<tr>
<td>Are the devices continuously resolved?</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Is the signal being sample rate converted?</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Example application</td>
<td>Simple digital transfer into the 896 from DAT deck or digital mixer.</td>
<td>Transfer from digital mixer running at a different sample rate.</td>
</tr>
</tbody>
</table>

Some example scenarios are demonstrated below.

Simple AES/EBU input transfer (no rate convert)

```
Master                      Other device
896 clock source setting: AES/EBU
AES/EBU OUT
AES/EBU IN
896 Sample Rate Conversion setting: None
```

Figure 3-18: Slaving the 896 to an AES/EBU device. For the 896's clock source, choose AES/EBU.

AES/EBU input with rate conversion

```
Master                      Other device
AES/EBU OUT
AES/EBU IN
896 clock source setting: Internal
896 Sample Rate Conversion setting: AES In
```

Figure 3-19: Rate-converting AES/EBU input.

AES/EBU input with word clock

```
'House' word clock master
AES/EBU OUT/IN
AES/EBU IN/OUT
896 clock source: word clock
896 Sample Rate Conversion setting: None
```

Figure 3-20: In this scenario, the 896 and other AES/EBU device are both resolved to one another via a third master word clock source.

Clocking scenarios for AES/EBU output

The 896 AES/EBU output can also employ sample rate conversion. The output options, shown below in Figure 3-21, are briefly summarized in the following sections. For further details, see “Sample Rate Conversion” on page 41.
INSTALLING THE MOTU 896 HARDWARE

Figure 3-21: The Sample Rate Conversion option in the MOTU FireWire Audio Control Panel gives you access to the AES/EBU output clock options. The last option is either “×2” or “÷2” depending on the system sample rate.

None
To make the AES/EBU output sample rate match the System sample rate, choose None. No sample rate conversion occurs when this setting is chosen.

AES Out slave to AES in
To make the AES/EBU output sample rate match the sample rate currently being received by the 896’s AES/EBU input, choose AES Input. This setting requires a connection to the 896’s AES/EBU input from a device that is transmitting an AES/EBU clock signal.

☛ Be careful when both the 896’s AES/EBU input and output are connected to the same external device: this option is likely to create a clock loop.

☛ When you are using the AES/EBU input as a clock source for sample rate conversion on the AES/EBU output, you cannot use the AES/EBU input for audio input.

AES Out x 2 / AES Out ÷ 2
Choose one of these sample rates when the desired AES/EBU output rate needs to be twice the 896 system clock rate (when the system clock is at either 44.1 or 48 kHz) or half the system clock rate (when the system clock is at 88.2 or 96 kHz). For further details about this option, see “Sample Rate Conversion” on page 41.

SYNCING TO WORD CLOCK
The 896 Word Clock input and output connectors allow you to synchronize the 896 with other devices via standard word clock connections.

Do you need word clock?
If you will be using only the 896’s analog inputs and outputs, and you have no plans to synchronize your 896 system to SMPTE time code, you don’t need word clock.

Situations that require word clock sync
If either of the following situations are true, you’ll need to use the 896’s word clock sync features:

• You need to resolve the 896 with other digital audio devices so that they share a common timebase.

• You need to synchronize the 896 system to SMPTE time code, such as from a video deck or an analog multi-track tape recorder, as explained earlier in “Sync to SMPTE, word clock, video” on page 24.

Choose a digital audio clock master
In either of the above cases, you need to choose an audio clock master (as explained in Figure 3-16 on page 27). In the simplest case, you have two devices and one is the word clock master and the other is the slave as shown below in Figure 3-22 and Figure 3-23.

Figure 3-22: Slaving another digital audio device to the 896. For the 896’s clock source, choose any source.
INSTALLING THE MOTU 896 HARDWARE

Figure 3-23: To slave the 896 to SMPTE time code, use a dedicated synchronizer such as a MOTU MIDI Timepiece AV or Digital Timepiece. For the 896’s clock source, choose ‘Word clock’. You could also use ADAT SYNC from the MTP AV connected to the ADAT SYNC IN port on the 896.

Don’t chain word clock
If you have three or more digital audio devices that you need to synchronize, avoid chaining their word clock connections (OUT to IN, OUT to IN, etc.), as this causes problems. Instead, use a dedicated synchronizer like the Digital Timepiece or a word clock distribution device of some kind.

Slaving to 2x and 1/2x word clock
The 896 has the ability to slave to a word clock signal running at half the 896’s current system clock. For example, the 896 could be running at 96 kHz while slaving to a 48 kHz word clock signal from a MOTU Digital Timepiece. Conversely, the 896 could run at 48 kHz and slave to 96 kHz word clock.

Remember, the word clock signal must be one of the following:

- The same as the 896 system clock
- Half the 896 system clock
- Twice the 896 system clock

For example, if the 896 is running at 96 kHz, it cannot slave to word clock running at 44.1 kHz.

The 896 offers several audio sync formats
Remember, you have several ways to slave an 896 to a synchronizer like the Digital Timepiece. You can use word clock (connected to the 896 itself), ADAT SYNC (connected to the PCI-324 card) or Digital Timepiece Control Track (connected to the PCI-324 card). These latter two connections free up the Digital Timepiece’s word clock output for another device that only supports word clock.

SYNCING LARGE SYSTEMS
If you are connecting the MOTU 896 to a lot of other digital audio gear, get a Digital Timepiece. It can synchronize a wide variety of devices, and it offers sample accurate synchronization for devices that support it, such as ADATs. You will also be able to control everything from the transport controls of your audio software. If you have even more devices than a single Digital Timepiece can support, consider a word clock distribution device, such as the Aardvark Aard Sync™ II video-to-word clock converter. Products like this offer multiple word clock outputs and an extremely low-jitter clock.
CONNECTING MULTIPLE MOTU 896 INTERFACES

You can daisy-chain up to four MOTU 896 interfaces on a single FireWire bus, with the restrictions described in the following sections. Most computers have only one built-in FireWire bus (even if it supplies multiple FireWire sockets). Connect them as follows:

Multiple 896s in the MOTU FireWire Audio Control Panel

The MOTU FireWire Audio Control Panel displays the settings for one 1296 I/O at a time. To choose which I/O you are looking at, choose it from the Interface menu shown below in Figure 3-25.

Synchronizing multiple 896s

The entire 896 system gets its clock from whatever you choose from the Clock Source menu in the MOTU FireWire Audio Control Panel. When you connect multiple 896 I/Os or other MOTU FireWire interfaces, all of their respective sync sources are displayed in the menu as shown below in Figure 3-26.
INSTALLING THE MOTU 896 HARDWARE

32

Word clock connections are not necessary
Each 896 in the system gets its clock from the Audio Wire cable connection (unless it is the master clock itself). There is no need to make word clock connections between multiple 896 I/Os.

Connecting a MOTU 828
You can add a MOTU 828 to the end of a MOTU 896 FireWire daisy chain (because the 828 has only one FireWire port), or you can mix and match multiple 896’s and 828’s using a standard FireWire hub. Up to four interfaces can be combined on one FireWire bus.

Operating multiple 896 interfaces at high sample rates
Four MOTU 896 interfaces (or mixed and matched 896 and 828 interfaces) can operate at 44.1 kHz or 48 kHz on a single FireWire bus. When operating 896 interfaces at a high sample rate (88.2 or 96 kHz), ADAT optical becomes disabled (because it does not support these sample rates). As a result, the 896 carries 10 channels of audio (8 analog and 2 AES/EBU). At a sample rate of 88.2 kHz allows you to run up to three 896s (with 10 channels each). At 96 kHz, you can operate no more than two 896s on a single FireWire bus.

Adding additional interfaces with a second FireWire bus
Third-party FireWire bus expansion products in the form of a cardbus (“PC card”) adaptor or PCI card allow you to add a second FireWire bus to your computer. In may be possible to add additional MOTU FireWire interfaces connected to such a third-party product, depending on the performance of the product and the performance of your host computer.

Managing the IDs of multiple interfaces
As shown in Figure 3-25 on page 31, multiple MOTU 896 interfaces are identified by number (#1, #2, #3, etc.) Interfaces are ID’d (given a number) by the order in which they are first powered up after being connected. This information is stored in the MOTU FireWire Audio preferences file. Once ID’d, they retain the same number regardless of the order in which they are powered up. You can disable an interface at any time with the Disable interface option shown in Figure 3-25 on page 31. Doing so frees up the FireWire bandwidth required by the interface without turning it off. Switching off an interface accomplishes the same thing. To get the MOTU FireWire Audio Control Panel to forget about an interface entirely, you’ll see a Forget button in the MOTU FireWire Audio Control Panel. Just click the Forget button and the MOTU FireWire Audio Control Panel will no longer consider the interface to be present but off line (turned off).
CHAPTER 4 Installing the MOTU 896 Macintosh Software

OVERVIEW
The MOTU 896 ships with the following software components:

<table>
<thead>
<tr>
<th>Software component</th>
<th>Location</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>MOTU FireWire Audio Driver</td>
<td>Extensions Folder</td>
<td>Allow the MOTU 896 to establish communication with the computer.</td>
</tr>
<tr>
<td>MOTU 896 Enabler</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MOTU Folder</td>
<td>Extensions Folder</td>
<td>Contains the MOTU hard disk recording engine. Required for MOTU 896 operation with AudioDesk and Digital Performer.</td>
</tr>
<tr>
<td>MOTU FireWire Audio Control Panel</td>
<td>Apple menu (Control Panels Folder)</td>
<td>Provides access to all of the settings in the MOTU 896 hardware.</td>
</tr>
<tr>
<td>MOTU FireWire Control Strip</td>
<td>Control Strip (Control Strip Modules Folder)</td>
<td>Provides access to all of the settings in the MOTU 896 hardware.</td>
</tr>
<tr>
<td>AudioDesk Workstation Software</td>
<td>Top level of the startup disk</td>
<td>Provides complete multi-track recording, mixing and processing. Optional.</td>
</tr>
<tr>
<td>ASIO MOTU FireWire Audio Driver</td>
<td>In the ASIO Drivers folder of your audio software—other than AudioDesk or Digital Performer</td>
<td>Allows ASIO-compliant audio software to do multi-channel input and output with the MOTU 896. Only required if you are using Cubase VST or another ASIO-compatible program.</td>
</tr>
<tr>
<td>AudioDesk Demo Project</td>
<td>Anywhere you want</td>
<td>Provides a multi-track mix that you can open, play, and mix in AudioDesk. Optional.</td>
</tr>
</tbody>
</table>

RUNNING THE MOTU 896 SOFTWARE INSTALLER
Insert the Macintosh and Windows compatible installer CD-ROM into your Macintosh and run the MOTU Audio/AudioDesk installer on the CD. It will guide you through the installation. If you are unsure about what components to install, refer to the rest of the sections in this chapter, which explain the purpose of each software item.

MOTU FIREWIRE AUDIO DRIVER AND ENABLER
These two MacOS System Extensions allow the MOTU 896 to communicate with the computer. They must always be enabled in your extension set, along with any MacOS FireWire system extensions.
MOTU FOLDER
The MOTU Folder goes in the Extensions Folder inside the System Folder on the Macintosh startup disk.

The MOTU Folder contains the hard disk recording engine for AudioDesk and Digital Performer. It also holds the real-time effects processing plug-ins used by AudioDesk and Digital Performer.

Figure 4-1: The MOTU Folder contains the MOTU hard disk recording engine for AudioDesk and Digital Performer.

MOTU FIREWIRE AUDIO CONTROL PANEL
The MOTU FireWire Audio Control Panel is placed by the installer in your Mac's Apple menu (under Control Panels). It gives you access to all of the settings in the MOTU 896 hardware, such as the sample rate. For complete details, see chapter 5, “MOTU FireWire Audio Control Panel” (page 37).

Figure 4-2: The MOTU FireWire Audio Control Panel gives you access to all of the settings in the MOTU 896 hardware.
MOTU FIREWIRE CONTROL STRIP MODULE
The MOTU FireWire Control Strip module is placed by the installer in your Mac's Control Strip. Just like the MOTU FireWire Audio Control Panel, it gives you access to all of the settings in the MOTU 896 hardware. For complete details, see chapter 5, “MOTU FireWire Audio Control Panel” (page 37).

AUDIODESK WORKSTATION SOFTWARE
The MOTU 896 installer places AudioDesk on the top level of your Macintosh's startup volume.

AudioDesk is an advanced workstation software package for the MOTU 896 that lets you record, edit, mix, process, bounce and master multi-track digital audio recording projects. Advanced features include real-time 32-bit effects processing, sample-accurate synchronization with ADATs, 24-bit recording, and much more.

See the AudioDesk manual included with your MOTU 896 system for details.
ASIO MOTU FIREWIRE AUDIO DRIVER

ASIO stands for Audio Streaming Input and Output. The ASIO MOTU FireWire Audio driver allows MOTU 896 to provide multi-channel input and output for Steinberg’s Cubase VST software, or any other audio application that supports ASIO drivers.

The ASIO MOTU FireWire Audio driver is only required if you are using Cubase VST (or another audio program that relies on the ASIO driver to support multi-channel I/O with the MOTU 896).

Digital Performer and AudioDesk support ASIO, but they also access the MOTU 896 directly through the MOTU Audio System, so it is not necessary to use the ASIO driver with these MOTU applications.

The ASIO MOTU FireWire Audio driver should be placed in the ASIO folder of Cubase VST or other ASIO-compliant software that you are running as the software “front end” for the MOTU 896.

For details about using Cubase VST with the MOTU 896, see chapter 8, “The MOTU 896 and Other Audio Software” (page 57).
CHAPTER 5  MOTU FireWire Audio Control Panel

OVERVIEW
The MOTU FireWire Audio Control Panel provides access to all MOTU 896 settings. These settings can also be accessed from the MOTU FireWire Control Strip module or from the Configure Hardware Driver command in AudioDesk or Digital Performer (Basics menu).

ACCESSING THE MOTU 896 SETTINGS
There are several ways to access the MOTU FireWire Audio Control Panel settings:

- From the Apple menu, choose the MOTU FireWire Audio Control Panel
- From the MacOS control strip, click on the MOTU FireWire Control Strip Module
- From within AudioDesk™ or Digital Performer™, choose Basics menu> MOTU Audio System options> Configure Hardware Driver
- From within Cubase (Version 5 or higher), click the ASIO Control Panel button in the System Setup dialog as shown in Figure 8-3 on page 59.
- From within other ASIO-compatible programs, refer to their documentation.
It doesn't matter which way you access the MOTU 896 settings. They are the same in all three places.

MOTU 896 SETTINGS

Sample Rate
Choose the desired Sample Rate for recording and playback. The MOTU 896 can operate at 44.1 KHz (the standard rate for compact disc audio), 48 KHz, 88.2 KHz or 96 KHz.

Mismatched sample rates cause distortion and crackling. If you hear this sort of thing, check the sample rate settings in your hardware and here in the MOTU FireWire Audio Control Panel.

Clock Source
The Clock Source determines the digital audio clock that the MOTU 896 will use as its time base. For a complete explanation of synchronization issues, see “Making sync connections” on page 19. The following sections briefly discuss each clock source setting.

Internal
Use the Internal setting when you want the MOTU 896 to operate under its own digital audio clock. For example, you may be in a situation where all you are doing is playing tracks off hard disk in your digital audio software on the computer. In a situation like this, you most often don't need to reference an external clock of any kind.

Another example is transferring a mix to DAT. You can operate the MOTU 896 system on its internal clock, and then slave the DAT deck to the MOTU 896 via the AES/EBU connection (usually DAT decks slave to their AES/EBU input when you choose the AES/EBU input as their record source).

If you would like help determining if this is the proper clock setting for your situation, see "Do you need a synchronizer?" on page 20.

With ADAT devices, however, you usually want an external digital audio synchronizer, such as the MIDI Timepiece AV or Digital Timepiece, to be the digital clock master. In this case, you would set the MOTU 896 clock source setting to ADAT 9-pin, as described below.

ADAT 9-pin
The ADAT 9-pin clock source setting refers to the ADAT digital audio synchronization format. It allows the MOTU 896 to slave to an ADAT — or ADAT sync chain — via its ADAT sync 9-pin connector. ADAT sync also carries precise, sample location information, which allows AudioDesk and Digital Performer to transfer audio to and from ADATs without drifting by as much as one sample.
Use this setting when you are using the MOTU 896 with one or more ADATs. Make sure the MOTU 896 is connected to the end of the ADAT sync chain.

You should also use this setting if you have a MIDI Timepiece AV, which allows you to drive your entire system from the transport controls of AudioDesk, Digital Performer or other computer software.

You could also use ADAT sync to continuously resolve the MOTU 896 to SMPTE time code, video, and word clock via a synchronizer like the MOTU MIDI Timepiece AV. Word clock can accomplish the same thing.

For further details, see “Sample-accurate sync with ADATs” on page 22, “ADAT sync with no synchronizer” on page 23 and “Sync to SMPTE, word clock, video” on page 24.

ADAT optical

The ADAT optical clock source setting refers to the clock provided by the MOTU 896’s optical input, when it is connected to an ADAT optical device. This setting can be used to slave the MOTU 896 directly to the optical input connection. Most of the time, you can set up a better operating scenario that uses one of the other synchronization options. However, there may be occasions when you have an ADAT optical compatible device that has no way of synchronizing digitally to the MOTU 896 or an external synchronizer such as the Digital Timepiece. In this case, the ADAT Optical clock source setting lets you slave the MOTU 896 to the device itself via its digital input to the MOTU 896.

If the ADAT Optical setting does not appear in the menu, it means that the MOTU 896’s optical input is currently turned off. If so, choose the ADAT format from the Optical input menu (Figure 5-1 on page 38).

This setting is also useful if you just need to make a simple, click-free digital transfer between the MOTU 896 and another device — where a time code reference and shared transport control are not needed — without having to set up an elaborate synchronization scenario.

For further details about this setting, see “Syncing optical devices” on page 25.

AES/EBU

The AES/EBU clock source setting refers to the AES/EBU input connector on the MOTU 896. This setting allows the MOTU 896 to slave to another AES/EBU device.

Use this setting whenever you are recording input from a DAT deck or other AES/EBU device into the MOTU 896. It is not necessary in the opposite direction (when you are transferring from the MOTU 896 to the DAT machine).

For further details about this setting, see “Syncing AES/EBU devices” on page 26.

Word Clock In

Choose this setting to slave the MOTU 896 to an external word clock source. For details, see “Syncing to word clock” on page 29.

Samples Per Buffer

A sample buffer is a small part of computer memory that briefly holds digital audio samples as they are passed between the computer and the MOTU 896.

The Samples Per Buffer setting lets you control the size of these buffers in the MOTU FireWire Audio Driver. A higher setting reduces the processing load on your computer; a lower setting reduces monitoring latency, which is the slight delay you hear when patching live audio through the MOTU 896 and your audio software. (See “Monitoring live input” on page 43 for further explanation.) For example, you might want to listen to the vocals you are recording with a little bit of reverb on them.
from a plug-in in your audio software. The signal that gets recorded to disk is 'dry’, but the signal in your headphones is 'wet’. Since the vocal material recorded to disk is dry, you then have the flexibility to apply real-time reverb to the track after recording and change it at any time (since the reverb is not ‘printed’ in the track). You can even automate changes to plug-in effects over time (if your software supports plug-in automation).

At a sample rate of 44.1 kHz, a Samples Per Buffer setting of 512 produces a round-trip delay (monitoring latency) of approximately 23 milliseconds (ms). A setting of 256 produces monitoring latency of around 12-13 ms, and the delay starts to become inaudible.

Monitoring latency has no effect on recording
It is important to note that monitoring latency only applies to the live signal as it is being monitored. It has no effect whatsoever on the timing accuracy of the material being recorded to hard disk. The system is precisely calibrated to record and play back hard disk audio perfectly on time.

Choosing the right ‘Samples per buffer’ setting
If you would like to process live inputs with plug-in effects in your software (such as putting a reverb plug-in on a vocal mic input or a guitar amp simulation plug-in on your guitar signal), make the Samples Per Buffer setting as low as possible. How low you can go depends on how fast your computer is and how much plug-in processing (and other processor-intensive tasks) you are using in your recording project. Try settings below 512 and if your computer begins to act sluggish, try raising them again to the next highest buffer setting until the computer feels responsive. If your computer doesn’t allow you to go low enough, try cueMix™ Plus monitoring (“Monitor input — CueMix™ Plus” below) and then apply plug-in processing to the disk track after it has been recorded.

Changing the ‘Samples Per Buffer’ setting
If you are at a point in your recording project where you are not currently working with live, patched-thru material (e.g. you’re not recording vocals), switch to a higher Samples Per Buffer setting. Depending on your computer’s CPU speed, you might find that settings in the middle work best and that your computer is much more responsive.

CueMix™ Plus monitoring
The MOTU 896’s CueMix™ Plus no-latency monitoring feature completely eliminates monitoring latency. For further information, see “Monitoring live input” on page 43.

Enable Sound Manager driver
Check the Enable Sound Manager option if you would like to route Sound Manager audio to and from the MOTU 896. For example, you could listen to an audio CD playing in the CD drive of your Macintosh through headphones connected to the MOTU 896. As another example, you could route audio from a pair of MOTU 896 inputs into a third-party Sound Manager-compatible audio application. Use the menus provided to choose the desired MOTU 896 inputs and outputs you would like to route to/from Sound Manager. For further details, see chapter 9, “Sound Manager” (page 63).

Enable Pedal
Check the Enable Pedal option if a foot switch is connected to the MOTU 896 and you would like to trigger recording punch in/out (or other software functions) with it. Use the Set buttons to determine what keystroke is trigger by the pedal-up and pedal-down positions. You can assign the pedal to any two keystrokes you wish. (You are not restricted to punch in/out.)

Interface menu
The general settings above this menu apply globally to all connected MOTU 896 interfaces (and other MOTU FireWire audio interfaces). The settings below this menu apply to a specific 896...
interface. If you have several 896's (or other MOTU FireWire audio interfaces) connected, you can view the settings for each interface by choosing it from this menu.

**Disable option**
Check this option to temporarily take an interface off line. Doing so frees up FireWire bandwidth for other devices without turning off the disabled 896.

**Optical input/output**
The Optical input and Optical output settings let you choose between ADAT ('lightpipe') or OFF. Turning it off frees up FireWire bandwidth. In other words, it opens up resources on the FireWire bus for other devices connected via FireWire.

**Monitor input — CueMix™ Plus**
The Monitor input settings enables the MOTU 896 CueMix™ Plus feature (Figure 5-4 on page 43), which lets you route an analog or AES/EBU input or input pair directly to the MOTU 896 main outs, where it is mixed with the signal on the main outs. Routing occurs with virtually no monitoring latency (audible delay), and the signal is passed through dry (with no signal processing of any kind). In addition, the CueMix Plus signal volume can be controlled (relative to the main mix volume) with the Monitor Level knob on the MOTU 896 front panel. For information about other ways to handle input monitoring, see "Monitoring live input" on page 43.

**Sample Rate Conversion**
This option lets you control AES/EBU sample rate conversion. Each option is explained below.

**None**
No sample rate conversion occurs. Both the AES/EBU input and output match the sample rate of the 896's system clock.

**AES In**
The AES/EBU input locks to the sample rate of the input signal (whatever it happens to be) and converts it to the 896 system clock rate. The Rate Conversion LEDs on the 896 front panel indicate the incoming sample rate and that rate conversion is occurring.

**AES Out slave to AES in**
To make the AES/EBU output sample rate match the sample rate currently being received by the 896's AES/EBU input, choose AES Input. This setting requires a connection to the 896's AES/EBU input from a device that is transmitting an AES/EBU clock signal.

☛ Be careful when both the 896's AES/EBU input and output are connected to the same external device: this option is likely to create a clock loop.

☛ When you are using the AES/EBU input as a clock source for sample rate conversion on the AES/EBU output, you cannot use the AES/EBU input for audio input.

**AES Out x 2 / AES Out ÷ 2**
Choose one of these sample rates when the desired AES/EBU output rate needs to be twice the 896 system clock rate (when the system clock is at either 44.1 or 48 kHz) or half the system clock rate (when the system clock is at 88.2 or 96 kHz). Either way, the AES/EBU output remains resolved to the 896 system clock. For further details about this option, see “Syncing AES/EBU devices” on page 26.

**Programmable Meters**
This option lets you choose which bank you wish to monitor with the eight programmable meters on the MOTU 896 front panel. Your choices are: Analog Out, ADAT In or ADAT Out.
AES/EBU Meters
This option lets you choose to monitor either AES/EBU input or output with the programmable AES/EBU meters on the MOTU 896 front panel.

Clip Hold Time
The Clip Hold Time option controls how long the top red LED remains illuminated after clipping occurs (see Figure 5-2 below).

Figure 5-2: The Clip Hold Time option.

If you want the ability to clear the LED manually from your host audio software or the Cue Mix Console, Choose Infinite from the Clip Hold Time menu. In Digital Performer or AudioDesk, you can clear the 1296 clip LEDs by choosing Audio menu>Clear All Clipping Indicators.

Peak Hold Time
The 896 front-panel level meters support standard peak/hold metering, where the LED for the highest level recently measured on the channel remains illuminated for a brief period of time while the rest of the LEDs below it remain fully dynamic. The Peak Hold Time controls how long the peak-hold LED remain illuminated before going dark again.

Word Out
If you are running a MOTU 896 interface at a high sample rate (96 or 88.2), this option appears at the bottom of the interface settings. It lets you choose a word clock output rate that either matches the global sample rate (e.g. 96 kHz) or halves the global rate (e.g. 48 kHz instead of 96 kHz).

Figure 5-3: There are two ways to monitor live audio inputs with the MOTU 896: 1) through the computer or 2) via CueMix™ Plus hardware monitoring. This diagram shows method 1 (through the computer). When using this method, use the MOTU 896’s Samples Per Buffer setting to reduce the slight delay you hear when monitoring the live input, but don’t lower it too much, or your computer will act sluggish.
MONITORING LIVE INPUT

There are two ways to monitor live audio input with the MOTU 896: 1) through the computer or 2) via CueMix™ Plus hardware monitoring. Figure 5-3 on page 42 below shows method 1, which allows you to add effects processing such as reverb and guitar amp effects via plug-ins in your audio software. See “Samples Per Buffer” on page 39 for details about how to reduce — and possibly eliminate — the audible monitoring delay that the computer introduces.

Figure 5-4 shows how to use CueMix™ Plus hardware-based monitoring, which lets you hear what you are recording with no monitoring delay and no computer-based effects processing. (You can add effects later, after you've recorded the live input as a disk track.) To learn more, see “Monitor input — CueMix™ Plus” on page 41.

If the material you are recording is suitable, there is a third way to monitor live input: use both methods (Figure 5-3 and Figure 5-4) at the same time. For example, you could route vocals to both the computer (for a bit of reverb) and mix that processed signal on the main outs with dry vocals from CueMix Plus.

IF MOTU 896 SETTINGS ARE GRAYED OUT

If the MOTU 896 FireWire driver is currently in use by an audio program (or Sound Manager), some of its settings cannot be changed and are therefore grayed out in the MOTU FireWire Audio Control Panel menus. (Settings that cannot be changed are ones on which audio applications continuously depend for smooth, error free operation.) If you find that a MOTU FireWire Audio Control Panel setting that you wish to change is grayed out, simply quit all MOTU 896-compatible audio programs (which may include Sound Manager-compatible programs, too, if you are using the MOTU 896 with Sound Manager). Once you have quite all applications, all MOTU FireWire Audio Control Panel settings will be available (not grayed out).

Figure 5-4: This diagram shows the signal flow when using CueMix™ Plus no-latency monitoring. Notice that this method does not allow you to process the live input with plug-ins in your audio software while it is being monitored. You can, however, add effects later — after recording the live input as a disk track. CueMix™ Plus lets you hear what you are recording with no delay and no computer-based effects.
CHAPTER 6  The MOTU 896 and Digital Performer

OVERVIEW
This chapter provides a brief overview of Digital Performer's basic I/O and synchronization operation with the MOTU 896 hardware. Digital Performer Version 2.42 or higher is required for the MOTU 896. Version 2.42 supports all of the advanced features of the MOTU 896, including sample-accurate synchronization with ADATs.

Setting up your system .................. .45
The MOTU 896 settings .................. .45
Be sure you have enough voices .......... .48
Trimming the analog inputs ............... .48
24-bit operation .......................... .48
Fine-tuning I/O timing .................. .48
Synchronization .......................... .48
MIDI Machine Control (MMC) ............ .49
Reducing delay when monitoring live inputs . .49
Using a foot switch .................. .49
Exchanging projects with AudioDesk ...... .50
Sound Manager and Digital Performer .... .50

SETTING UP YOUR SYSTEM
As described in chapter 4, “Installing the MOTU 896 Macintosh Software” (page 33), the Digital Performer and MOTU 896/AudioDesk software installers will properly install and update everything for you.

If you are using a MIDI Timepiece AV or Digital Timepiece for synchronization, be sure they are present in your FreeMIDI setup.

THE MOTU 896 SETTINGS
The MOTU 896 settings can be accessed by choosing MOTU Audio System options>Configure Hardware Driver from the Basics menu. If you don't see the MOTU 896 settings as shown below in Figure 6-1, choose MOTU 896 from the menu at the top of the Configure Hardware dialog. For complete details about the important settings in this window, see chapter 5, “MOTU FireWire Audio Control Panel” (page 37).

The following sections provide a brief explanation of each MOTU 896 setting for use with Digital Performer. For a more complete overview, see chapter 5, “MOTU FireWire Audio Control Panel” (page 37).
The 'Configure Hardware Driver' menu item produces the MOTU 896 settings shown above. This window provides all of the settings for your MOTU 896 hardware.

**Sample rate**
Choose 44.1, 48, 88.2 or 96 KHz as the overall sample rate for the MOTU 896 system and Digital Performer. Newly recorded audio in Digital Performer will have this sample rate. Imported audio or soundbites in existing files that do not match this sample rate will be displayed in the Soundbites window with a red 'X' on its move handle to indicate that it cannot be played. Use the commands in the Soundbites window mini-menu to sample rate convert the files, if desired.

**Clock Source**
This setting is very important because it determines which audio clock the MOTU 896 system will follow.

If you do not have any digital audio connections to your MOTU 896 (you are using the analog inputs and outputs only), and you will not be slaving Digital Performer to external SMPTE time code, choose Internal.

If you are slaving the MOTU 896 to the ADAT sync In or Word Clock In connector, choose ADAT 9-pin or Word Clock In, respectively.

If you have digital audio devices connected to the MOTU 896, or if you are not sure about the clock source of your setup, be sure to read “Making sync connections” on page 19 and “Clock Source” on page 38.

**Samples Per Buffer**
The Samples Per Buffer setting can be used to reduce the delay — or monitoring latency — that you hear when live audio is patched through your MOTU 896 hardware and Digital Performer. For example, you might have MIDI instruments, samplers, microphones, and so on connected to the analog inputs of the MOTU 896. If so, you will often be mixing their live input with audio material recorded in Digital Performer.

Smaller Samples Per Buffer settings reduce latency, but they also put more demand on your computer's processor (as shown in the Performance Monitor window). For best results, try 256 samples or lower, which reduces latency enough to be inaudible for most audio material. If Digital Performer gets sluggish, try the next higher setting until the
computer feels responsive enough to you. Keep an eye on the Processor meter in the Performance monitor when making this adjustment. Be sure to try playing some audio, too, as the processor meter can jump up significantly during playback at lower settings. You can also use Cue Mix Plus no-latency monitoring as described in “Monitoring live input” on page 43 and “Monitor input — CueMix™ Plus” on page 41.

**Figure 6-2:** When adjusting the ‘Samples Per Buffer’ to reduce monitoring latency, watch the ‘processor’ meter in the Performance Monitor. If you hear distortion, or if the Performance meter is peaking, try raising the Samples Per Buffer setting.

**Optical input and output**

To make a MOTU 896 optical input or output available in Digital Performer, turn them on in the optical input and/or output menu. If you won’t be using the optical connectors, turn them off.

**Auto Monitor**

The Auto Monitor option (Figure 6-1 on page 46) automatically changes the MOTU 896 CueMix™ Plus monitor input when you record-enable a track in Digital Performer whose output assignment is Analog 1-2. For example, if you record-enabled a track called guitar in your Digital Performer project, its audio output assignment is Analog 1-2, and its audio input assignment is analog 2, the MOTU 896 CueMix Plus Monitor Input setting (see “Monitor input — CueMix™ Plus” on page 41) will automatically be changed to analog input #2.

The Monitor Input option requires the following additional settings shown below in Figure 6-3:

1. From the Basics menu, choose MOTU Audio System options>Input Monitoring Mode.
2. Choose the Direct hardware playthrough option.

3. In the Audio Monitor window, turn on Audio Patch thru by enabling the headphone button shown below.

![Image]

**Figure 6-3:** To enable the CueMix™ Plus Auto Monitor feature in AudioDesk or Digital Performer, be sure the ‘Direct hardware playthrough’ option is chosen, and be sure audio patch thru is turned on.

☛ Remember: the Auto Monitor feature only responds to tracks whose output setting is Analog 1-2 (since the MOTU 896 CueMix Plus feature sends audio only to the main outputs).

**Auto Monitor playthrough is ‘dry’**

As you can see in Figure 6-3 above, there are two ways to monitor live audio input in Digital Performer: 1) directly through the audio hardware (the MOTU 896 only) or 2) through Digital Performer’s virtual mixing environment, which may include real-time plug-in effects processing on the live input signal. The Auto Monitor option discussed in the previous section requires method 1, and therefore does not allow plug-in effects processing. You can, however, employ both types of monitoring at the same time (both ‘dry’ hardware monitoring and ‘wet’ monitoring through Digital Performer) by choosing the Monitor record-enabled tracks through effects option shown in Figure 6-3 above and then manually choosing a Monitor Input in the MOTU FireWire Audio Control Panel (as discussed in...
“Monitor input — CueMix™ Plus” on page 41). For further information about monitoring live input, see “Monitoring live input” on page 43.

BE SURE YOU HAVE ENOUGH VOICES
Go to the Basics menu and choose MOTU Audio System Options>Configure Studio Size. Then check to make sure you have enough mono and stereo audio voices for the work you need to do. Consult the MOTU Audio System chapter in your Digital Performer manual for further information about the settings in this dialog.

TRIMMING THE ANALOG INPUTS
The MOTU 896 analog inputs provide trim knobs on the front panel. To calibrate an audio input:

1. Record-enable a track in Digital Performer.
2. Choose the desired MOTU 896 input for the track.
3. Open the Audio Monitor window.
4. As you feed signal to the input, adjust the input’s corresponding trim knob on the front panel of the MOTU 896 until peaks in the level meter are as high as possible without clipping (hitting zero dB).

24-BIT OPERATION
Your MOTU 896 hardware fully supports Digital Performer’s 24-bit recording capabilities, including both analog and digital 24-bit recording. If you would like to record and play back 24-bit audio files, go to the Basics menu, choose MOTU Audio System options>Configure Sample Format, and choose 24-bit recording as the sample format. This setting is saved with the Digital Performer project.

FINE-TUNING I/O TIMING
The MOTU 896 system has the ability to be sample accurate. This means that when you transfer audio between Digital Performer and an ADAT, for example, you can record the audio back and forth as many times as you want between them and it will remain exactly at its original sample location (unless you move it in Digital Performer, of course).

Occasionally, you may encounter a situation in which you observe a slight offset of one sample — or maybe a few — caused by inherent latencies in the devices you are using with the MOTU 896. Usually, these offsets will be consistent, and you can compensate for them in Digital Performer. To do so, choose MOTU Audio System Options>Fine-tune Audio I/O Timing from the Basics menu as shown in Figure 6-4.

SYNCHRONIZATION
Digital Performer can run under its own transport control or slave to an external sync source, such as SMPTE time code or ADAT sync (sample address).

Running DP under its own transport control
If you do not need to synchronize Digital Performer with time code or another recording device, such as a tape deck, just leave the Slave to External Sync command in the Basics menu unchecked.

However, even though Digital Performer is not slaving to external sync, you still need to be concerned with the synchronization of the MOTU 896’s digital audio clock with other devices connected to it digitally (if any). For example, if you have a digital mixer connected to the MOTU 896 via an ADAT optical lightpipe cable, you need to make sure that their audio clocks are phase-
locked. For details, see “Syncing optical devices” on page 25 and “Making sync connections” on page 19. If you don’t have any digital audio devices connected to the MOTU 896, digital audio phase-lock does not apply to you.

**Slaving DP and the MOTU 896 to SMPTE time code**

If you need to slave Digital Performer and the MOTU 896 system to SMPTE time code, choose Receive Sync from the Basics menu and choose the MTC (MIDI Time Code) option. Then make sure that the Slave to External Sync command in the Basic menu is checked. To ensure that your audio tracks don’t drift out of sync with your MIDI tracks — or time code, use a hardware synchronizer like the MIDI Timepiece AV or Digital Timepiece to slave the MOTU 896 hardware to the SMPTE (or MIDI Time) Code as well. An ADAT-compatible digital audio synchronizer like the MOTU MIDI Timepiece AV is required for drift-free SMPTE/MIDI time code sync. Make sure the MOTU 896 Clock Source setting (Figure 6-1 on page 46) is set to Word Clock In and you’ll need the synchronization setup shown in Figure 3-12 on page 24.

If you have an ADAT or ADAT sync-compatible device, don’t use SMPTE time code. Instead, use sample-accurate sync as described in the next section.

**Sample-accurate sync to ADAT**

Together, Digital Performer and the MOTU 896 system provide you with sample-accurate transfers with ADATs and any other devices that support standard ADAT sample address (ADAT Sync).

A sample-accurate transfer is one in which the original location of the audio is preserved in the transfer, down to the sample.

For details on how to set up sample-accurate sync, see “Sample-accurate sync” on page 21. Be sure to choose the Sample Accurate Sync option in Digital Performer’s Receive Sync dialog (Basics menu), and make sure that the Slave to External Sync command is checked in the Basic menu, too.

To control the transports of everything together from Digital Performer, see the next section.

**MIDI MACHINE CONTROL (MMC)**

If you have ADATS and a MMC-compatible ADAT synchronizer like the MIDI Timepiece AV or Digital Timepiece, you can control everything from your computer screen with Digital Performer’s transport controls and cueing features (like Markers, the playback wiper, etc.)

See the MIDI Machine Control chapter in your MIDI Timepiece AV or Digital Timepiece manual for details on how to set this up.

**REDUCING DELAY WHEN MONITORING LIVE INPUTS**

If you have live audio inputs connected to the MOTU 896, such as MIDI synthesizers, samplers, microphones or other live instruments, you might hear a slight delay when their audio is being patched through your MOTU 896 hardware and Digital Performer. There are several ways to reduce — and eliminate — this audible monitoring delay. For details, see “Monitoring live input” on page 43.

**USING A FOOT SWITCH**

Use a foot switch connected to the MOTU 896 to trigger recording punch-in and punch-out, or any other feature in Digital Performer that is assigned to a computer keystroke. By default, the foot switch triggers the 3 key on the computer keypad (which toggles Digital Performer’s record button.) To trigger a different set of keystrokes with the foot switch, visit the MOTU FireWire Audio Control Panel. (See “Enable Pedal” on page 40.)
EXCHANGING PROJECTS WITH AUDIODESK
Digital Performer (Version 2.6 or later) can exchange files with Audiodesk 1.0. For example, you can transfer a file from Digital Performer to Audiodesk, and back again. Just use Save As in Digital Performer's File menu and choose the Audiodesk file format. To open Audiodesk files in Digital Performer, just use the Open command. (No conversion is required beforehand in Audiodesk.)

If you have an earlier version of Digital Performer (2.5 or earlier), you can open your Digital Performer files in Audiodesk (with the Open command in the File menu), but Digital Performer 2.5 or earlier cannot open Audiodesk files.

SOUND MANAGER AND DIGITAL PERFORMER
Digital Performer includes a MOTU Audio System plug-in called AudioTap that allows you to route any Sound Manager audio into Digital Performer's mixing environment. From there, you can route it to your MOTU 896 interface via any of Digital Performer's extensive audio routing features. For details, consult your Digital Performer documentation.
CHAPTER 7  The MOTU 896 and AudioDesk

OVERVIEW
This chapter provides a brief overview of AudioDesk’s basic I/O and synchronization operation with the MOTU 896 hardware. For complete information about all of AudioDesk’s powerful workstation features, see the AudioDesk manual included with your MOTU 896 system.

Setting up your system ............... .51
The MOTU 896 settings ................. .51
Be sure you have enough voices .......... .54
Trimming the analog inputs ............ .54
24-bit operation ....................... .54
Fine-tuning I/O timing ................. .54
Synchronization ....................... .54
MIDI Machine Control (MMC) ........ .55
Reducing delay when monitoring live inputs .55
Using a foot switch .................... .55
Exchanging projects with Digital Performer .55
AudioDesk and MIDI sequencing ....... .56

SETTING UP YOUR SYSTEM
As described in chapter 4, “Installing the MOTU 896 Macintosh Software” (page 33), the MOTU 896/AudioDesk software installer will properly install everything for you.

If you will be using AudioDesk’s MIDI Machine Control (MMC) or MIDI Time Code sync features, FreeMIDI must be installed. (You can do this from the MOTU 896 installer CD.)

If you are using a MIDI Timepiece AV or Digital Timepiece for synchronization, be sure they are present in your FreeMIDI setup.

THE MOTU 896 SETTINGS
The MOTU 896 settings can be accessed by choosing MOTU Audio System options>Configure Hardware Driver from the Basics menu. If you don’t see the MOTU 896 settings as shown below in Figure 7-1, choose MOTU 896 from the menu at the top of the Configure Hardware dialog. For complete details about the important settings in this window, see chapter 5, “MOTU FireWire Audio Control Panel” (page 37).

The following sections provide a brief explanation of each MOTU 896 setting for use with AudioDesk. For a more complete overview, see chapter 5, “MOTU FireWire Audio Control Panel” (page 37).
The 'Configure Hardware Driver' menu item produces the MOTU 896 settings shown above. This window provides all of the settings for your MOTU 896 hardware.

**Sample rate**
Choose either 44.1 or 48 KHz as the overall sample rate for the MOTU 896 and AudioDesk. Newly recorded audio in AudioDesk will have this sample rate. Imported audio or soundbites in existing files that do not match this sample rate will be displayed in the Soundbites window with a red 'X' on its move handle to indicate that it cannot be played.

**Clock Source**
This setting is very important because it determines which audio clock the MOTU 896 system will follow.

If you do not have any digital audio connections to your MOTU 896 (you are using the analog inputs and outputs only), and you will not be slaving AudioDesk to external SMPTE time code, choose **Internal**.

If you have digital audio devices connected to the MOTU 896, or if you are not sure about the clock source of your setup, be sure to read "Making sync connections" on page 19 and "Clock Source" on page 38.

**Samples Per Buffer**
The Samples Per Buffer setting can be used to reduce the delay — or monitoring latency — that you hear when live audio is patched through your MOTU 896 hardware and AudioDesk. For example, you might have MIDI instruments, samplers, microphones, and so on connected to the analog inputs of the MOTU 896. If so, you will often be mixing their live input with audio material recorded in AudioDesk.

Smaller Samples Per Buffer settings reduce latency, but they also put more demand on your computer's processor (as shown in the Performance Monitor window). For best results, try 256 samples or lower, which reduces latency enough to be inaudible for most audio material. If AudioDesk gets sluggish, try the next higher setting until the computer feels responsive enough to you. Keep an eye on the Processor meter in the Performance monitor when making this adjustment. Be sure to try playing some audio, too, as the processor meter can jump up significantly during playback at lower settings.
You can also use Cue Mix Plus no-latency monitoring as described in “Monitoring live input” on page 43 and “Monitor input — CueMix™ Plus” on page 41.

Figure 7-2: When adjusting the ‘Samples Per Buffer’ to reduce monitoring latency, watch the ‘processor’ meter in the Performance Monitor. If you hear distortion, or if the Performance meter is peaking, try raising the Samples Per Buffer setting.

Optical input and output
To make a MOTU 896 optical input or output available in AudioDesk, turn them on in the optical input and/or output menu. If you won’t be using the optical connectors, turn them off.

Auto Monitor
The Auto Monitor option (Figure 7-1 on page 52) automatically changes the MOTU 896 CueMix™ Plus monitor input when you record-enable a track in AudioDesk. For example, if you record-enabled a track called guitar in your AudioDesk project, its audio output assignment is Analog 1-2, and its audio input assignment is analog 2, the MOTU 896 CueMix Plus Monitor Input setting (see “Monitor input — CueMix™ Plus” on page 41) will automatically be changed to analog input #2.

The Monitor Input option requires the following additional settings shown below in Figure 7-3:

1 From the Basics menu, choose MOTU Audio System options>Input Monitoring Mode.

2 Choose the Direct hardware playthrough option.

3 In the Audio Monitor window, turn on Audio Patch thru by enabling the headphone button shown below.

Figure 7-3: To enable the CueMix™ Plus Auto Monitor feature in AudioDesk or AudioDesk, be sure the ‘Direct hardware playthrough’ option is chosen, and be sure audio patch thru is turned on.

☛ Remember: the Auto Monitor feature only responds to tracks whose output setting is Analog 1-2 (since the MOTU 896 CueMix Plus feature sends audio only to the main outputs).

Auto Monitor playthrough is ‘dry’
As you can see in Figure 7-3 above, there are two ways to monitor live audio input in AudioDesk: 1) directly through the audio hardware (the MOTU 896 only) or 2) through AudioDesk’s virtual mixing environment, which may include real-time plug-in effects processing on the live input signal. The Auto Monitor option discussed in the previous section requires method 1, and therefore does not allow plug-in effects processing. You can, however, employ both types of monitoring at the same time (both ‘dry’ hardware monitoring and ‘wet’ monitoring through AudioDesk) by choosing the Monitor record-enabled tracks through effects option shown in Figure 7-3 above and then manually choosing a Monitor Input in the MOTU FireWire Audio Control Panel (as discussed in “Monitor input — CueMix™ Plus” on page 41). For further information about monitoring live input, see “Monitoring live input” on page 43.
BE SURE YOU HAVE ENOUGH VOICES
Go to the Basics menu and choose MOTU Audio System Options>Configure Studio Size. Then check to make sure you have enough mono and stereo audio voices for the work you need to do. Consult the MOTU Audio System chapter in your AudioDesk manual for further information about the settings in this dialog.

TRIMMING THE ANALOG INPUTS
The MOTU 896 analog inputs provide trim knobs on the front panel. To calibrate an audio input:

1. Record-enable a track in AudioDesk.
2. Choose the desired MOTU 896 input for the track.
3. Open the Audio Monitor window.
4. As you feed signal to the input, adjust the input’s corresponding trim knob on the front panel of the MOTU 896 until peaks in the level meter are as high as possible without clipping (hitting zero dB).

24-BIT OPERATION
Your MOTU 896 hardware fully supports AudioDesk’s 24-bit recording capabilities, including both analog and digital 24-bit recording. If you would like to record and play back 24-bit audio files, go to the Basics menu, choose MOTU Audio System options>Configure Sample Format, and choose 24-bit recording as the sample format. This setting is saved with the AudioDesk project.

FINE-TUNING I/O TIMING
The MOTU 896 system has the ability to be sample accurate. This means that when you transfer audio between AudioDesk and an ADAT, for example, you can record the audio back and forth as many times as you want between them and it will remain exactly at its original sample location (unless you move it in AudioDesk, of course).

Occasionally, you may encounter a situation in which you observe a slight offset of one sample — or maybe a few — caused by inherent latencies in the devices you are using with the MOTU 896. Usually, these offsets will be consistent, and you can compensate for them in AudioDesk. To do so, choose MOTU Audio System Options>Fine-tune Audio I/O Timing from the Basics menu as shown in Figure 7-4.

SYNCHRONIZATION
AudioDesk can run under its own transport control or slave to an external sync source, such as SMPTE time code or ADAT sync (sample address).

Running AudioDesk under its own transport control
If you do not need to synchronize AudioDesk with time code or another recording device, such as a tape deck, just leave the Slave to External Sync command in the Basics menu unchecked.

However, even though AudioDesk is not slaving to external sync, you still need to be concerned with the synchronization of the MOTU 896’s digital audio clock with other devices connected to it digitally (if any). For example, if you have a digital mixer connected to the MOTU 896 via an ADAT optical lightpipe cable, you need to make sure that their audio clocks are phase-locked. For details, see “Syncing optical devices” on page 25 and “Making sync connections” on page 19. If you don’t have any digital audio devices connected to the MOTU 896, digital audio phase-lock does not apply to you.
Slaving AudioDesk and the MOTU 896 to SMPTE time code

If you need to slave AudioDesk and the MOTU 896 system to SMPTE time code, choose Receive Sync from the Basics menu and choose the MTC (MIDI Time Code) option. Then make sure that the Slave to External Sync command in the Basic menu is checked. To ensure that your audio tracks don’t drift out of sync with the SMPTE time code, use a hardware synchronizer like the MIDI Timepiece AV or Digital Timepiece to slave the MOTU 896 hardware to the SMPTE (or MIDI Time) Code as well. An ADAT sync-compatible digital audio synchronizer is required for drift-free SMPTE/MIDI time code sync. Make sure the MOTU 896 Clock Source setting (Figure 7-1 on page 52) is set to Word Clock In and you’ll need the synchronization setup shown in Figure 3-12 on page 24.

☛ If you have an ADAT or ADAT sync-compatible device, don’t use SMPTE time code. Instead, use sample-accurate sync as described in the next section.

Sample-accurate sync to ADAT or Control Track

Together, AudioDesk and the MOTU 896 system provide you with sample-accurate transfers with ADATs and any other devices that support standard ADAT sample address (ADAT Sync).

A sample-accurate transfer is one in which the original location of the audio is preserved in the transfer, down to the sample.

For details on how to set up sample-accurate sync, see “Sample-accurate sync” on page 21. Be sure to choose the Sample Accurate Sync option in AudioDesk’s Receive Sync dialog (Basics menu), and make sure that the Slave to External Sync command is checked in the Basic menu, too.

To control the transports of everything together from AudioDesk, see the next section.

MIDI MACHINE CONTROL (MMC)

If you have ADATs and a MMC-compatible ADAT synchronizer like the MIDI Timepiece AV or Digital Timepiece, you can control everything from your computer screen with AudioDesk’s transport controls and cueing features (like Markers, the playback wiper, etc.)

See the MIDI Machine Control chapter in your MIDI Timepiece AV or Digital Timepiece manual for details on how to set this up.

REDUCING DELAY WHEN MONITORING LIVE INPUTS

If you have live audio inputs connected to the MOTU 896, such as MIDI synthesizers, samplers, microphones or other live instruments, you might hear a slight delay when their audio is being patched through your MOTU 896 hardware and AudioDesk. There are several ways to reduce — and eliminate — this audible monitoring delay. For details, see “Monitoring live input” on page 43.

USING A FOOT SWITCH

Use a foot switch connected to the MOTU 896 to trigger recording punch-in and punch-out, or any other feature in AudioDesk that is assigned to a computer keystroke. By default, the foot switch triggers the 3 key on the computer keypad (which toggles AudioDesk’s record button.) To trigger a different set of keystrokes with the foot switch, visit the MOTU FireWire Audio Control Panel. (See “Enable Pedal” on page 40.)

EXCHANGING PROJECTS WITH DIGITAL PERFORMER

AudioDesk 1.0 can exchange files with Digital Performer (Version 2.6 or later). For example, you can transfer a file from Digital Performer to AudioDesk, and back again. Just use Save As in Digital Performer’s File menu and choose the AudioDesk file format. To open AudioDesk files in
Digital Performer, just use the Open command. (No conversion is required beforehand in AudioDesk.)

If you have an earlier version of Digital Performer (2.5 or earlier), you can open your Digital Performer files in AudioDesk (with the Open command in the File menu), but Digital Performer 2.5 or earlier cannot open AudioDesk files.

AUDIODESK AND MIDI SEQUENCING
AudioDesk can play audio as a background application, allowing you to run a sequencer at the same time in the foreground. However, there is no way to continuously synchronize — or resolve — a sequencer with AudioDesk, so the two programs will eventually drift out of sync, even if you manage to start them at the same time. If you’d like to do integrated MIDI sequencing, your best bet is Digital Performer, which offers pretty much all of the same features as AudioDesk, along with powerful, state-of-the-art MIDI sequencing. Talk to your authorized MOTU dealer for details about upgrading from AudioDesk to Digital Performer.
CHAPTER 8 The MOTU 896 and Other Audio Software

OVERVIEW
The MOTU 896 includes an ASIO driver that provides multi-channel I/O with any ASIO-compatible audio software.

ASIO driver support is required. 57
Check your setup with AudioDesk first 58
Check the MOTU FireWire Audio ASIO driver 58
Check the MOTU FireWire Audio Control Panel 58
Enable the MOTU FireWire Audio ASIO driver 58
Number of audio channels 59
Working with MOTU 896 inputs and outputs 59
Trimming the analog inputs 60
Using a foot switch 60
Changing MOTU 896 settings 60
Reducing delay when monitoring live inputs 60
Audio clock source 60
Synchronization 60
MIDI Machine Control (MMC) 62
24-bit operation 62

ASIO DRIVER SUPPORT IS REQUIRED
ASIO is an acronym for Audio Streaming Input and Output. The ASIO MOTU FireWire Audio driver allows the MOTU 896 to provide multi-channel audio input and output for any audio application that supports ASIO drivers.

For multi-channel operation with third-party audio software, the MOTU 896 requires ASIO compatibility. If your host audio program does not support ASIO, contact the developer.

Sample-accurate sync
The MOTU FireWire Audio ASIO driver supports sample-accurate sync (via the MOTU 896’s ADAT sync feature) for applications that support it.

Attention: Digital Performer users
Digital Performer supports ASIO, but it also accesses the MOTU 896 directly through the MOTU Audio System, so it is not necessary to use the ASIO driver with Digital Performer.

Attention: Cubase VST users
Cubase VST Version 5 is used for the examples in this chapter. However, there is no significant difference between the Version 5 examples shown and what you see in Version 4. The basic procedures are the same.

Attention: Other software users
Cubase VST is used for the examples in this chapter. However, the basic procedures are the same and can be easily applied to any ASIO-compatible software. Just follow the general descriptions at the beginning of each main section in this chapter. Consult your software documentation for details about each topic, if necessary.
CHECK YOUR SETUP WITH AUDIODESK FIRST

Before you run your third-party audio software with the MOTU 896, launch AudioDesk and play back the demo project to make sure that the MOTU 896 hardware and software drivers are set up properly. The AudioDesk demo project is located on the MOTU 896 Installer CD-ROM. Drag it to your hard drive before opening it in AudioDesk, as your CD-ROM drive probably will be too slow to play the audio.

CHECK THE MOTU FIREWIRE AUDIO ASIO DRIVER

For Cubase and most other ASIO-compatible programs, the ASIO MOTU FireWire Audio driver should be placed in the ASIO folder of the ASIO-compliant software that you are running as the software “front end” for the MOTU 896. To check this quickly, use your computer’s search utility (Sherlock or other utility) and search using the word ASIO. Drag the ASIO MOTU FireWire Audio driver to the appropriate folder, if necessary. If you can’t find it, run the MOTU 896 installer again and do a Custom Install.

CHECK THE MOTU FIREWIRE AUDIO CONTROL PANEL

Before you run your audio software, launch the MOTU FireWire Audio Control Panel to configure your MOTU 896 hardware. The MOTU FireWire Audio Control Panel lets you choose the audio clock source, and it lets you enable the optical input and output, if needed. For details, see chapter 5, “MOTU FireWire Audio Control Panel” (page 37).

ENABLE THE MOTU FIREWIRE AUDIO ASIO DRIVER

Once you’ve made the preparations described so far in this chapter, you’re ready to run your audio software and enable the MOTU FireWire Audio driver. Check the audio system or audio hardware configuration window in your software. There will be a menu there that lets you choose among various ASIO drivers that may be in your system. Choose the MOTU 896 from this menu.
Enabling the MOTU FireWire Audio ASIO driver in Cubase
To activate the MOTU FireWire Audio ASIO driver in Cubase:

1. Choose System from the Audio menu.
2. Choose MOTU FireWire Audio from the ASIO device menu.
3. Make the other settings in the dialog as need for your system and synchronization scenario.

For example, if you are using analog only, you only need 8 channels. If you are using analog and AES/EBU, you need 10 channels.

As another example, if you are using analog, AES/EBU and ADAT optical, you need 18 channels (the maximum number of simultaneous channels provided by the MOTU 896).

In Cubase, set the number of channels in the System dialog (as shown above in Figure 8-3).

WORKING WITH MOTU 896 INPUTS AND OUTPUTS
Once you've enabled the MOTU FireWire Audio ASIO driver in your host audio software, MOTU 896 audio inputs and outputs will appear in your software's input/output menus, and you can set them up and use them as any standard audio input and output. If you don't see the optical inputs and/or outputs, check the MOTU FireWire Audio Control Panel to make sure they are turned on and set to the format you require. If you don't plan to use the optical input or output, turn it off to conserve computer bandwidth.

MOTU 896 inputs/outputs in Cubase
Once you've chosen the MOTU FireWire Audio ASIO driver in the Audio System dialog, choose Audio Inputs from the Audio menu to see the MOTU 896 inputs. To activate them, click the Active light next to each input. Once you’ve activated the MOTU 896 inputs, you can then assign them to Cubase audio channels in the Monitor window in the usual fashion (by command-clicking on the input button at the top of each channel strip). MOTU 896 outputs appear in the Master window as output assignments for the master fader and busses.

NUMBER OF AUDIO CHANNELS
Be sure to configure your audio software so that it has enough audio channels (or voices) to cover the 18 channels of input and output provided by the MOTU 896:

- 8 channels for analog I/O
- 2 channels for AES/EBU
- Zero or 8 channels for optical, depending on whether you have optical turned off or on
Figure 8-4: Use the output buttons at the bottom of each channel strip to assign MOTU 896 outputs to busses. You can then assign channels in the Monitor window to each bus as desired.

TRIMMING THE ANALOG INPUTS
The MOTU 896 analog inputs provide trim knobs on the front panel. Use the level meters on the 896’s front panel to calibrate these inputs before recording. As you feed signal to the MOTU 896 analog input, adjust the input’s corresponding trim knob on the front panel until peaks are as high as possible without clipping (hitting zero dB).

USING A FOOT SWITCH
Use a foot switch connected to the MOTU 896 to trigger recording punch-in and punch-out, or any other feature in your host audio software that is assigned to a computer keystroke. By default, the foot switch triggers the 3 key on the computer keypad. To trigger a different set of keystrokes with the foot switch, visit the MOTU FireWire Audio Control Panel. (See “Enable Pedal” on page 40.)

CHANGING MOTU 896 SETTINGS
You can change the MOTU 896 settings at any time by accessing either the MOTU FireWire Audio Control Panel or the Control Strip module. (See “Accessing the MOTU 896 settings” on page 37.) However, some settings are grayed out and cannot be changed when the MOTU FireWire Audio ASIO driver is active (when a program is currently using it). Therefore, you may need to quit your audio software to change the desired MOTU 896 setting.

REDUCING DELAY WHEN MONITORING LIVE INPUTS
If you have live audio inputs connected to the MOTU 896, such as MIDI synthesizers, samplers, microphones or other live instruments, you might hear a slight delay when their audio is being monitored through your MOTU 896 hardware and your host audio program. (In Cubase, this delay is displayed under Latency in the Audio System dialog shown in Figure 8-3.) There are several ways to reduce — and eliminate — this audible monitoring delay. For details, see “Monitoring live input” on page 43.

AUDIO CLOCK SOURCE
If you have devices connected to the MOTU 896 digital inputs (optical or AES/EBU), or if you need to synchronize MOTU 896 digital audio and your host audio software to an external sync source, be sure the MOTU 896 clock source is set properly. For complete information, see “Making sync connections” on page 19 and “Clock Source” on page 38.

SYNCHRONIZATION
If your audio software has the ability to slave to SMPTE time code or perform sample-accurate digital audio transfers with Alesis ADAIIs, then it can take advantage of the synchronization features in the MOTU 896.

As you read through the following sections to decide what form of synchronization you might need with other devices in your studio, be sure to consult “Making sync connections” on page 19 for the proper hardware connections. Use the synchronization diagrams to be clear about how you will be synchronizing your audio software and the MOTU 896 to the other components of your system.
Synchronizing digital audio connections
If you have devices connected to the MOTU 896 digital inputs (optical or AES/EBU), you need to be concerned with the synchronization of the MOTU 896's digital audio clock with other devices connected to it digitally (if any). For example, if you have a digital mixer connected to the MOTU 896 via an ADAT optical lightpipe cable, you need to make sure that their audio clocks are phase-locked. For details, see “Syncing optical devices” on page 25 and “Making sync connections” on page 19. If you don't have any digital audio devices connected to the MOTU 896, digital audio phase-lock does not apply to you.

Slaving to SMPTE time code
If you need to slave your audio software and the MOTU 896 system to SMPTE time code, follow the instructions in your software's manual for slaving it to MIDI Time Code (MTC). To ensure that your audio tracks don't drift out of sync with your MIDI tracks or the time code, use a hardware synchronizer like the MOTU MIDI Timepiece AV or Digital Timepiece to slave the MOTU 896 hardware to the SMPTE (or MIDI Time) Code as well. A digital audio synchronizer is required for drift-free SMPTE/MIDI time code sync. Make sure the Clock Source setting in the MOTU FireWire Audio Control Panel is set to Word Clock In. For examples of how to set this up, see “Sync to SMPTE, word clock, video” on page 24.

Sample-accurate sync to ADAT
If your audio software supports sample-accurate synchronization, the MOTU 896 provides sample-accurate digital transfers between the computer and ADATs, or any other device that supports standard ADAT sample address (ADAT Sync).

A sample-accurate digital transfer is one in which the original location of the audio is preserved in the transfer, down to the sample.

For details on how to connect your hardware for sample-accurate sync, see “Sample-accurate sync” on page 21. For software setup, consult your audio software documentation.

Sample-accurate sync with Cubase
For sample-accurate sync in Cubase, set up Cubase as follows:

1. In Cubase's MIDI System Setup window, set OMS compatibility to No OMS. VST does not appear to be able to achieve sample-accurate sync when running under OMS.

2. In Cubase's Audio System Setup window (Audio menu), choose an Audio Clock Source setting of ADAT 9-pin.

3. In Cubase's Synchronization window, set the Sync Source Time Base to ASIO 2.0 as shown below:

![Figure 8-5: Setting up sample-accurate sync via ASIO 2.](image)

4. Enable SYNC in the Controls window.

![Figure 8-6: Enabling the SYNC button.](image)

5. Begin playback from the sample-accurate sync source (ADAT, etc.) Transport control is handled by the sample-accurate sync source.
The ASIO 2.0 MMC setting in Cubase
The Timecode Base menu shown above in Figure 8-5 includes a setting called ASIO 2.0 MMC, which provides sample-accurate transport control of the MOTU MIDI Timepiece AV (or other MMC-compatible synchronizer) from the transport buttons in Cubase itself.

MIDI MACHINE CONTROL (MMC)
If your audio software supports MIDI Machine Control (MMC), and you have ADATs and a MMC-compatible ADAT synchronizer like the MIDI Timepiece AV, you can control everything from the transport controls and cueing features in your audio software (like the playback wiper, etc.) See “Sample-accurate sync to ADAT” on page 61 for details on how to set this up.

24-BIT OPERATION
Your MOTU 896 hardware fully supports 24-bit recording in any audio software that supports it. Simply enable 24-bit operation as instructed by the software. The MOTU 896 system always supplies the software with a 24-bit data stream, and when you enable 24-bit operation, it simply uses all 24-bits supplied by the MOTU 896 hardware.
CHAPTER 9  Sound Manager

OVERVIEW
Sound Manager is a standard Mac OS System Extension that provides stereo sound capabilities on your Power Macintosh. The MOTU 896 system extensions support Sound Manager. This support allows your Power Macintosh to use any pair of inputs and outputs (analog or digital) on the MOTU 896, instead of the Mac's built-in audio inputs/outputs (if any).

Using 3rd party audio software ..............63
Sound Manager is stereo only..................63
Sound Manager supports 44.1 and 48 kHz only..63
Enabling Sound Manager I/O..................64
The Sound control panel.......................64
Changing the inputs or outputs ...............65
Monitoring live inputs..........................65
AudioTap™ and Digital Performer..............65

USING 3RD PARTY AUDIO SOFTWARE
Just about every application for Macintosh that supports audio also supports Sound Manager. Once you've installed the MOTU 896 software, you can use any pair of MOTU 896 inputs and outputs (analog or digital) to record and play back audio from any Sound Manager compatible program.

SOUND MANAGER IS STEREO ONLY
Sound Manager currently only supports stereo input and output. Therefore, Sound Manager compatible programs can only record two channels at a time with your MOTU 896 hardware. Similarly, they can play back audio through one stereo output pair on the MOTU 896, although most multi-track audio applications can internally mix more than two tracks to stereo. Consult your software's documentation for details.

SOUND MANAGER SUPPORTS 44.1 AND 48 KHZ ONLY
The MOTU 896 can run at 44.1, 48, 88.2 or 96 kHz. However, Sound Manager only supports 44.1 kHz and 48 kHz (in OS8 and OS9 — future versions may support higher sample rates). Therefore, you must set the MOTU 896 to run at 44.1 or 48 kHz to use it with Sound Manager.
ENABLING SOUND MANAGER I/O
Use the MOTU FireWire Audio Control Panel or Control Strip to enable Sound Manager I/O and choose the inputs and outputs that you wish to use for Sound Manager I/O.

THE SOUND CONTROL PANEL
Set up the Sound control panel for the MOTU 896 as follows:

1. Open the Sound Control Panel.
2. Choose Alert Sounds from the menu.

3. Lower the Alert volume. This prevents the Macintosh alert sound from blurring out of the MOTU 896.
4. Choose Input from the menu and click MOTU 896.
5. Choose the desired MOTU 896 input source from the menu provided (as shown above in Figure 9-2).
6. Choose Output from the menu and click MOTU 896.
That's it. You can now run any Sound Manager compatible audio software, and play back audio through the MOTU 896 outputs you've chosen in the MOTU FireWire Audio Control Panel.

**CHANGING THE INPUTS OR OUTPUTS**

Change the MOTU 896 inputs or outputs being used by Sound Manager in the MOTU FireWire Audio Control Panel or Control Strip module.

**MONITORING LIVE INPUTS**

If you would like to listen to live inputs as you are recording them into your Sound Manager application, you need to use the MOTU 896’s CueMix™ Plus feature. For details, see “Monitor input — CueMix™ Plus” on page 41.

**AUDIOTAP™ AND DIGITAL PERFORMER**

Digital Performer includes a MOTU Audio System plug-in called AudioTap that allows you to route any Sound Manager audio into Digital Performer’s mixing environment. From there, you can route it to your MOTU 896 interface via any of Digital Performer’s extensive audio routing features. For details, consult your Digital Performer documentation.
CHAPTER 10 Troubleshooting

Using Pro Tools, Sound Manager and -50 error
When using Sound Manager, Pro Tools software will only allow audio input via the Macintosh’s Built-in hardware. Therefore, you cannot use the MOTU 896 as the input device to Pro Tools software. If the MOTU FireWire Audio driver is selected as the input device in the Sound Control Panel, Pro Tools will return a -50 error and not launch. You can, however, select Built-in as the input device and the MOTU 896 as the output device in the Sound Control Panel. After doing so, you can run Pro Tools and monitor your output through the MOTU 896.

Sample accurate sync in AudioDesk and Digital Performer
When you first use sample accurate sync, be sure to go to the Receive Sync dialog in Digital Performer or AudioDesk and switch from “MTC” to “Sample-accurate.”

Apple CD Player will not play through audio interface
The Apple CD Player in OS 8.6 or earlier is programmed to only output to the Built-in Sound Manager hardware. The Apple CD Player in OS 9 and later is capable of playing audio to any Sound Manager compatible audio hardware. There are also several 3rd party CD audio applications available that are capable of playing audio to any Sound Manager compatible audio hardware.

Cubase - MOTU 896 inputs and outputs are not visible in Cubase
You probably need to enable them in Cubase.

Monitoring MOTU 896 input via Sound Manager
With the MOTU 896 and Sound Manager, you monitor input via CueMix™ Plus. For details, see “Monitor input — CueMix™ Plus” on page 41.

Can't authenticate AudioDesk
When installing software off the CD-ROM, the OK button does not become active until you have entered in your name and a valid keycode. Your name must contain at least 3 characters, and you must enter the keycode exactly as it appears in your AudioDesk manual (on the inside of the back cover).

MOTU FireWire Audio Control Panel or Control Strip module settings are grayed out for no apparent reason
Some settings cannot be accessed while the MOTU 896 is active. Quit all audio software that uses the MOTU 896 (including any Sound Manager applications, if any), and then the MOTU 896 settings should no longer be grayed out.

ADAT-compatible tape decks - converting 48kHz tracks to 44.1kHz
If the audio on your ADAT tape was recorded at 48kHz, then you must transfer that audio into your host software at 48kHz. If you plan to digitally mix this data and burn an audio CD, you must convert your audio to 44.1kHz with your host software. Once you sample rate convert your audio to 44.1kHz, you will have to set the sample rate in the console back to 44100 so you can play the file. You always want your digital clocks and sample rates to match when dealing with any kind of digital audio transfer or synchronizing.

ADAT-compatible tape decks - device order in MIDI Machine Control window
When powered on, most modular digital multi tracks ‘wake up’ configured to record from their analog inputs by default. You won’t be able to record from the MOTU 896 to a MDM until it is

Sample accurate sync in AudioDesk and Digital Performer
When you first use sample accurate sync, be sure to go to the Receive Sync dialog in Digital Performer or AudioDesk and switch from “MTC” to “Sample-accurate.”

Apple CD Player will not play through audio interface
The Apple CD Player in OS 8.6 or earlier is programmed to only output to the Built-in Sound Manager hardware. The Apple CD Player in OS 9 and later is capable of playing audio to any Sound Manager compatible audio hardware. There are also several 3rd party CD audio applications available that are capable of playing audio to any Sound Manager compatible audio hardware.

Cubase - MOTU 896 inputs and outputs are not visible in Cubase
You probably need to enable them in Cubase.

Monitoring MOTU 896 input via Sound Manager
With the MOTU 896 and Sound Manager, you monitor input via CueMix™ Plus. For details, see “Monitor input — CueMix™ Plus” on page 41.
switched to digital input. Tip: configure this in ClockWorks or AudioDesk if you want your decks to come up in the right mode when powered on.

The order of devices in the DTP panel of the MIDI Machine Control window is not controlled by the order of connections to the MOTU 896. This can be confusing unless you make them match when connecting the system.

**No input on an ADAT tape deck**
If you are having trouble recording on your ADAT tape deck from the MOTU 896, check the Digital input setting. After power cycling, tape decks often come up configured to record from their analog inputs. You won’t be able to record from the MOTU 896 to a tape deck until it is switched to digital input. Tip: configure this in ClockWorks or AudioDesk if you want your decks to come up in the right mode when power cycled.

**ADATs and the DTP - lock up time allowances**
ADATs can take a while to sync to the DTP. For example, when recording from the MOTU 896 to the ADATs, they may appear to chase and lock, but the record button continues to flash. Recorded data on the tape won’t be sample accurate until the record light stops flashing. Solution: add more pre-roll time.

**Alesis blackface (classic) ADAT optical sync**
If you are using a Classic (black-faced) ADAT as a sync master in your MOTU 896 setup, and you want to record sample accurately into it, you must configure it to use its internal clock, instead of slaving to the optical input. To do this, hold down the SET LOCATE button and press the DIGITAL IN button. This will toggle the ADAT between external sync (shown as "diG") and internal sync ("int"). Note that the ADAT will return to the "diG" setting each time it is powered off.

**Alesis ADAT track offset**
If you find that sample accurate transfers from an ADAT are displaced by a small amount, try to reset the ADAT to its factory default state. This is accomplished by powering on the ADAT while holding down the RECORD and PLAY keys simultaneously. The ADAT ix uses a 'soft' power key so ix users will have to unplug and plug the ADAT ix while holding down the RECORD and PLAY keys.

**Clicks and pops under word clock sync**
Many problems result from incorrect word clocking. It is essential that all digital devices in the system be word locked. Consult “Making sync connections” on page 19 for detailed information on how to word clock your gear. Whenever there is any weird noise or distortion, suspect incorrect word lock.

**Clicks and pops under ADAT Sync**
Sometimes, the ADAT sync cable seems to be plugged into the MOTU 896, and it partially works. But it isn't really all the way in. This can cause clicks when slaved to ADAT 9-pin. Make sure the ADAT Sync cable plug is really seated firmly.

**Clicks and pops due to hard drive problems**
If you have checked your clock settings and you are still getting clicks and pops in your audio, you may have a drive related problem. Set your Clock Source to Internal and try recording just using the analog inputs and outputs of the MOTU 896. If you encounter the same artifacts you may want try using another drive in your computer. Clicks and pops can also occur when the drive is severely fragmented, the disk drivers are outdated, or if you are using a SCSI accelerator that is not optimally configured for working with audio.
Connecting or powering gear during operation
It is not recommended that you connect/desconnect, or power on/off devices connected to the MOTU 896 while recording or playing back audio. Doing so may cause a brief glitch in the audio.

No optical inputs or outputs are available in host audio application
Check to make sure you have the desired optical inputs and/or outputs enabled in the MOTU FireWire Audio Control Panel.

Monitoring - How to monitor inputs?
Please refer to the documentation for the audio application that you are using. If your application does not support input monitoring, you will need to use the MOTU 896’s hardware-based CueMix Plus monitoring feature. Please see “Monitor input — CueMix™ Plus” on page 41.

Controlling monitoring latency
See “Monitoring live input” on page 43.

CUSTOMER SUPPORT
We are happy to provide customer support to our registered users. If you haven’t already done so, please take a moment to complete the registration card included with your MOTU 896. When we receive your card, you’ll be placed on our mailing list for free software updates and information about new products.

REPLACING DISKS
If your MOTU 896 software or AudioDesk CD-ROM becomes damaged and fails to provide you with fresh, working copies of the software, our Customer Support Department will be glad to replace it. You can request a replacement disc by calling our business office at (617) 576-2760 and asking for the customer service department.

TECHNICAL SUPPORT
If you are unable, with your dealer’s help, to solve problems you encounter with the MOTU 896 system, you may contact our technical support department in one of the following ways:

- Tech support hotline: (617) 576-3066 (Monday through Friday, 9 am to 6 pm EST)
- Tech support 24-hour fax line: (617) 354-3068
- Tech support email: techsupport@motu.com
- Web site: www.motu.com

Please provide the following information to help us solve your problem as quickly as possible:

- The serial number of the MOTU 896 system. This is printed on a sticker placed on the bottom of the MOTU 896 rack unit. You must be able to supply this number to receive technical support.
- Software version numbers for:
  — AudioDesk
  — The version numbers of the items in the MOTU Folder (in the Extensions Folder of your startup disk), including the MOTU 896 Enabler and MOTU FireWire Audio driver
- A brief explanation of the problem, including the exact sequence of actions which cause it, and the contents of any error messages which appear on the screen.
- The pages in the manual which refer to the parts of the MOTU 896 or AudioDesk with which you are having trouble.
- The version or creation date of the system software you are using to run the Macintosh. This can be found by choosing About this Computer from the Apple menu.
We're not able to solve every problem immediately, but a quick call to us may yield a suggestion for a problem which you might otherwise spend hours trying to track down.

Our technical support department is dedicated to helping registered users solve their problems quickly. In the past, many people have also taken the time to write to us with their comments, criticism and suggestions for improved versions of our products. We thank them; many of those ideas have been addressed in our development efforts. If you have features or ideas you would like to see implemented, we'd like to hear from you. Please write to the MOTU 896 Development Team, MOTU Inc., 1280 Massachusetts Avenue, Cambridge, MA 02138.
Digital Performer 47

Balanced analog 16
Bias Peak 57

CakeWalk 57
Calibrating audio input/output 48, 54
Clip Hold Time 42
Clock source 7, 19, 38
ADAT 9-pin 23, 24
AudioDesk 52
Condenser mic input 5
Configure Hardware Driver 7, 37
Configure interface 31
Connecting multiple 896s 31
Control Panel (MOTU 828) 7
Control Panel (MOTU FireWire Audio) 34, 37
Control Strip 33
Control Strip module (828) 7
Control Strip module (FireWire Audio) 37
Control Strip module (MOTU FireWire) 35
Converters 6, 10
Cubase 59
896 inputs/outputs 59
enabling the MOTU FireWire Audio ASIO driver 59
troubleshooting 67
CueMix Plus 11, 40, 41
choosing inputs 7
output jacks 6, 16
volume control 5
Customer support 69

Digital mixer 18
Fine-tune Audio I/O Timing command 48, 54
FireWire 11
connecting 15
connector 6
Foot switch 10, 40
3rd party software 60
AudioDesk 55
configuring 7
Digital Performer 49
jack 5
Forget button 32

Guitar
connecting 17

Headphone jack 5, 11
Headphones
connecting 17

Input gain 11
Inputs
analog 6
optical 6
Installation
hardware 15
software 33
Installer CD
replacing 69
Interface menu 40
Internal (sync setting) 38

Latency 11, 39, 40, 46, 52
CueMix Plus 7
w/3rd party software 60
LEDs 11
Level meters
configuring 42
Lightpipe 25
Logic Audio 57

Main outs 10
choosing CueMix monitor inputs 7
jacks 6
making connections to 16
volume 5
Main volume 5
Metering 11
Metering options 42
Mic inputs
connecting 17
phantom power 5
Mic preamps 10
Mic/line inputs 16
MIDI Machine Control 20, 21, 49, 62
MIDI Time Code sync 20, 21
MIDI Timepiece AV 22
Mixing
using an external mixer 16
MMC 20, 21, 49, 62
Monitor input 7, 41
Monitor level 5
Monitoring 11, 39, 40, 43
thru main outs 16
w/3rd party software 60
MOTU
Digital Timepiece 22
MIDI Timepiece AV 22
MOTU 828
rear panel overview 9
summary of features 9
MOTU 828 Control Panel 7
MOTU 828 Control Strip module 7
MOTU 896
expansion 31
installing 15
MOTU Audio System
bit resolution 38
Fine-tune Audio I/O Timing 48, 54
input/output timing 48, 54
location 34
MOTU FireWire Audio
ASIO driver 36
MOTU FireWire Audio Console 33
MOTU FireWire Audio Control Panel 34, 37
MOTU FireWire Audio Driver 33
MOTU FireWire Audio driver 33
MOTU FireWire Audio Enabler 33
MOTU FireWire Control Strip module 35, 37
MOTU Folder 33
location 34
MTC sync 20, 21
Optical connectors 6, 16
enabling/disabling 7, 41
overview 10
sync 25
Outputs
analog 6
optical 6
Packing list 13
Peak 57
Peak Hold Time 42
Pedal 10, 40
3rd party software 60
AudioDesk 53
configuring 7
Digital Performer 49
jack 5
Phantom power 5, 10, 16
Phase-lock 19
Phones 5
Pro Tools 67
Problem-solving 67
Programmable meters option 41
Punch in/out 10
Registration 13
Sample rate 7, 38
AudioDesk 52
Sample Rate Conversion option 41
Sample-accurate sync 10, 21, 22, 23, 61
Samplers
connecting 17
Samples per buffer 7, 39, 46, 52
SMpte sync 19, 20, 21, 24
Software
installation 33
Sound Control Panel 64
Sound control panel rate (bit resolution) 38
Sound Manager 57, 63
bit resolution 57
enabling 40
input/output timing 48, 54
Studio setup (example) 17
Sync
sample-accurate 21, 22, 23
Synchronization 19, 29
3rd party software 60
AudioDesk 54
Digital Performer 48
Synths
connecting 17
System requirements
minimum 13
recommended computer 12, 13
Technical support 69
Timecode Base menu 62
Trim (input) 11
Troubleshooting 67
TRS connectors 16
Unbalanced analog 16
Video sync 19, 24
Volume
headphone 11
VST 57
Word clock 10, 19, 24, 29
Word Clock In
Clock Source setting 39
Word Out option 42
Yamaha 02R
connecting 18
Yamaha 02R mixer 25